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Technolégiai javaslatok a szerkezeti valtoztatasokra

Az Feature Class-okhoz tartoz6 észrevételeket, javaslatokat az elemkod tablazat megfelelé pontjai
tartalmazzak. Ezek a technikai észrevételek/javaslatok arra iranyulnak, hogy a kartografiai
szempontok alapjan kialakitott, MicroStation (dgn) allomanyok adatszerkezetén milyen atalakitasokat
lenne célszerii végezni els6é kdrben ahhoz, hogy a felépitése egy térinformatikai térképészeti
adatbazishoz kozelitsen. A leiras tartalmazza az esetleges atalakitasok modjat is. A javaslatok
leirasakor térekedtem a pillanatnyilag kialakitott (kért) szerkezet megtartasira. Azoknal az elemeknél,
ahol kiilén Feature Class-ok lettek felvéve, a régi (pillanatnyi) FC-k is megtartasra keriilnének, mivel a
kartografalasi technoldgia erre az adatszerkezetre lett kialakitva. Az adatszolgaltatas a pillanatnyi
szerkezeti felépitésbol torténik.

Osszefoglalva az észrevételeket:
Az atalakitasok leginkabb a feliilet és vonal tipusu FC-ket érint.

A feliilet tipusi FC-k esetében az a gond, hogy a vonalas elemek felszeletelik a kiilsnben
ogikailag/tartalmilag 6sszetartozo foltokat.

Ezeket a feldarabolt feliileteket célszerli lenne egybe masolni. Erre a GeoMedia-ban a megfeleld
funkcié hasznalataval van lehetdség. Automatizalni nem lehet a dolgot, mert a feliileteknél egyenként
kell eldonteni, hogy mi az, ami Osszetartozik és ez altal Gsszevonhatd. Mérlegelni kell az egyes
feliileteknél, hogy mi az, ami nem vonhaté Ossze. Példaul abban az esetben, ha egy kétvonalas
objektum oszt ketté egy foltot, akkor nem hiba, nem kell dsszevonni. Illetve, ha egy nﬁvénym

tényleges tartalmi valtozds van, abban az esetben jogos a kettéosztas, Wﬂlﬂmﬂ
Oket.

A vonalas tipusu FC-k esetében két probléma meriilt fel. Az elsé esetben a vonalas objektumot egyéb
vonalas objektumok szaggatjdk tobb szakaszra. Ezeket a szakaszokat a GeoMedia megfelel6
funkciodjaval dssze lehet fiizni.

A masik probléma, ha a vonalas objektum folytonossaga is megszakad. Példaul amikor a hidak és az
atereszek szakitjak meg az ut folytonossagat.

Ezeket a szakadédsokat kézi digitalizalassal kell Osszekotni, biztositva ezzel az adott objektum
folytonossagat. Ez egy uthalézatnal elengedhetetlen, térinformatikai szempontbol.

Amennyiben a fentiekben megemlitett problémak korrigalasra keriilnek, az egész allomanyon
sziikséges egy olyan hibakeresést lefuttatni, ami megmutatja az ,,apr6” szakadasokat és tullégasokat.
Ez a GeoMedia fwﬁmkciéjéval lehetséges. A lekérdezésként kapott hibalistat
végig kell nézni és a valddi hibakat javitani kell.

A pont tipusi FC-k esetében egy olyan vizsgalatot kell elvégezni, hogy az adott objektum a helyén

van-e. Példaul egy pontszerii objektum egy vonalas objektumhoz kapcsolddik, akkor valdban rajta
van-e.




1 A - ALAP- ES HATARPONTOK
1.1 AA_pont — Alappontok

Feature Class: AA_pont
Geometriai tipus: PONT

Ennél az FC-nél kialakitott elem tipusok és a hozzajuk kapcsolédé attribitumok megfeleléek
egy térinformatikai adatbazishoz.

A valtoztatas nem sziikséges!



2 B-HATAROK és KOZIGAZGATASI EGYSEGEK
2.1 BA_vonal — Hatarok

Feature Class: BA_vonal
Geometriai tipus: VONAL

Ennél az FC-nél kialakitott elem tipusok €s a hozzajuk kapcsolédd attribitumok megfeleléek egy
térinformatikai adatbézishoz.

A mintaszelvény alapjan ezen FC elemei nem folytonosak.

Az elemeket kézi digitalizAlassal folytonossa kell tenni.

2.2 BB_felulet — Kbzigazgatasi_egységek

Feature Class: BB_felulet
Geometriai tipus: FELULET

Ennél az FC-nél kialakitott elem tipus és a hozza kapcsolodd attributumok megfeleldek egy
térinformatikai adatbazishoz.
A GVOP-ban a kozigazgatasi egységek hatarolé vonalai vannak tarolva. Ezt tartalmazza az el6z6 FC
(BA_vonal). —
Igy a kozigazgatasi egységeket mar a konvertalast kovetéen a GeoMedia-ban kell digitalizalni.
Ennek egyik modja a kézi digitalizalas lenne, de a szoftver megfelelé funkcidinak hasznalatival ez
ler6vidithetd és a tévesztési lehetoség is minimalizalhato.
Interactive Area By Face — ezzel a funkciéval kiilonbozé FC-kben 1évé vonalas elemek altal
lehatarolt tertiletbdl lehet egy megadott FC-be (feliilet tipusi) feliiletet 1étrehozni.
A funkcié hasznalatanak eldfeltétele, hogy a feliilet 1étrehozasdhoz felhasznilandé vonalas elemek
folytonosak legyenek €s a valosagban vagy térben kapcsolodjanak vagy metsszék egymast.
A menete:
- A Legend ablakban jeldljiik ki a feliilet hatarainak kialakitdsaban résztvevo FC-ket
- Edit > Select by Legend Entry
- Insert -> Interactive Area By Face...
-A Select Feature Class ablakban (térkép ablak bal felsGsarkan) allitsuk be a cél FC-t, majd alljunk
ra arra a teriiletre, melyet létre akarunk hozni.
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3 C — EPULETEK és EPITMENYEK
3.1 CA_felulet — Kozépiiletek

Feature Class: CA_felulet
Geometriai tipus: FELULET

Ennél az FC-nél kialakitott elem tipusok és a hozzajuk kapcsolédd attribitumok megfeleléek egy
térinformatikai adatbazishoz.

A valtoztatds nem sziikséges!

3.2 CB_felulet — Ipari, lizemi, kereskedelmi épiiletek, épitmények

Feature Class: CB_felulet
Geometriai tipus: FELULET

Ennél az FC-nél kialakitott elem tipusok és a hozzajuk kapcsoldédéd attribitumok megfeleloek egy
térinformatikai adatbazishoz.

A valtoztatas nem sziikséges!

3.3 CB_pont — Epiiletek, épitmények

Feature Class: CB_pont
Geometriai tipus: PONT

Ennél az FC-nél kialakitott elem tipusok é€s a hozzajuk kapcsolédd attributumok megfeleloek egy
térinformatikai adatbézishoz.

A valtoztatas nem sziikséges!

3.4 CC_felulet — Mezdgazdasagi épiiletek, épitmények

Feature Class: CC _felulet
Geometriai tipus: FELULET

Ennél az FC-nél kialakitott elem tipusok és a hozzajuk kapcsolédoé attributumok megfeleldek egy
térinformatikai adatbazishoz.

A véltoztatas nem sziikséges!



3.5 CD_felulet — Kozlekedési épiiletek, épitmények

Feature Class: CD_felulet
Geometriai tipus: FELULET

Ennél az FC-nél kialakitott elem tipusok €s a hozzdjuk kapcsolodd attributumok megfeleloek egy
térinformatikai adatbazishoz.

A véltoztatas nem sziikséges!

3.6 CE_felulet — Vallasi épiiletek, épitmények

Feature Class: CE_felulet
Geometriai tipus: FELULET

Ennél az FC-nél kialakitott elem tipusok é€s a hozzijuk kapcsolddé attribtitumok megfeleldek egy
térinformatikai adatbazishoz.

A véltoztatds nem sziikséges!

3.7 CF_felulet — Egyéb épiiletek, épitmények

Feature Class: CF_felulet
Geometriai tipus: FELULET

Ennél az FC-nél kialakitott elem tipusok é€s a hozzajuk kapcsolddd attriblitumok megfeleléek egy
térinformatikai adatbazishoz.

A valtoztatds nem szikséges!

3.8 CG_vonal — Keritések, falak

Feature Class: CG_vonal
Geometriai tipus: VONAL

Ennél az FC-nél kialakitott elem tipusok és a hozzajuk kapcsoldédo attribtitumok megfeleléek egy
térinformatikai adatbézishoz.

A véltoztatas nem sziikséges!
A minta szelvényen nem tapasztaltam folytonossagi problémakat.



4 D — KOZLEKEDES

4.1 DA_felulet — Kozlekedési létesitmények

Feature Class: DA_felulet
Geometriai tipus: FELULET

Ennél az FC-nél kialakitott elem tipusok és a hozzajuk kapcsolodd attributumok megfeleléek egy
térinformatikai adatbazishoz.

Ennél az FC-nél is feladat a feliiletek Osszevonasa. Az utak feliiletét felszabdaljdk a vonalas
objektumok és a feliileti objektumként lerakott hid objektumok.

A részteriiletek Osszevondsat a konvertalast kévetéen a GeoMedia megfeleld funkcidjaval lehet
elvégezni:

Edit - Feature > Merge

4.2 DA_vonal — Kbzlekedési létesitmények

Feature Class: DA_vonal
Geometriai tipus: VONAL

Ennél az FC-nél kialakitott elem tipusok és a hozzajuk kapcsol6dé attribitumok megfeleldek egy
térinformatikai adatbazishoz.

Az egyvonalas utaknal is Ossze kell kotni azokat a szakaszokat, amelyeket a hidak és atereszek
szétszabdalnak és ez altal nem folytonosak.

Az uthalozat térinformatikai hasznalhat6saga miatt létre kell hozni ebben az FC-ben a TUC attribitum
alatt kodokat és az AP030-as F_CODE alatt bedigitalizalni-a-pillanatnyilag-feliileti_objektumként
térolt ithdlézatot. o

Ennek %ﬁﬁ\gﬂ@iﬂanamyﬂag feliileti objektum kézépvonalan torténne. Betartva az objektum
folytonossagat. '

4.3 DA_pont — Kozlekedés létesitmények

Feature Class: DA_pont
Geometriai tipus: PONT

Ennél az FC-nél kialakitott elem tipusok és a hozzajuk kapcsolédo attributumok megfeleldek egy
térinformatikai adatbézishoz.

A véltoztatas nem sziikséges!



4.4 DB_vonal — Vast, drétkotélpalya

Feature Class: DB_vonal
Geometriai tipus: VONAL

Ennél az FC-nél kialakitott elem tipusok és a hozzajuk kapcsol6édé attributumok megfeleldek egy
térinformatikai adatbazishoz.

A valtoztatds nem sziikséges!

A minta szelvényen, egy helyen volt folytonossagi hiba, de az elvileg a digitalizalasb6l adédott, nem
altalanos.

4.5 DB_pont — Vasit

Feature Class: DB_pont
Geometriai tipus: PONT

Ennél az FC-nél kialakitott elem tipusok és a hozzajuk kapcsolédé attributumok megfeleloek egy
térinformatikai adatbéazishoz.

A valtoztatds nem sziikséges!

4.6 DC_felulet — Hidak,atkel6k

Feature Class: DC_felulet
Geometriai tipus: FELULET

Ennél az FC-nél kialakitott elem tipusok és a hozzajuk kapcsol6dd attributumok megfeleléek egy
térinformatikai adatbazishoz.

Amennyiben a feliileti objektumként tarolt uthalézat bedigitalizéldsra kertil a vonalas tipusi FC-be
(DA _vonal FC-be keriilne), akkor a hidakat, melyek most 4-6 darab feliilettel vannak régzitve az
adatbazisban (az ut megszakad €s a hianyz6 szakasz helyét t6ltik ki ezek a feliiletek € ezek adjak ki a
hid feliiletét), az Ut tengelyének vonaldban kell vonalas tipusi objektumként a DC_vonal FC-be
digitalizalni.

1
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4.7 DC_vonal — Hidak, atkel6k

Feature Class: DC_vonal
Geometriai tipus: VONAL

Ennél az FC-nél kialakitott elem tipusok és a hozzajuk kapcsoldédé attributumok megfeleléek egy
térinformatikai adatbazishoz.

A véltoztatas nem sziikséges!

4.8 DC_pont — Hidak, atkeldk

Feature Class: DC_pont
Geometriai tipus: PONT

Ennél az FC-nél kialakitott elem tipusok és a hozzajuk kapcsoldédé attributumok megfeleléek egy
térinformatikai adatbazishoz.

Amennyiben a feliileti objektumként tarolt uthalozat bedigitalizalasra keriil a vonalas tipusu FC-be,
akkor az atereszeket, melyek most két ponttal vannak rogzitve az adatbazisban (az 0t két szélén
vannak a beszlrasi pontok), az uttengelyre kell digitalizalni (egy darab beszurasi ponttal).

10



5 E— KOZTERULETEK és EGYEB TERULETEK
5.1 EA_felulet — Belteriileti kdzteriiletek

Feature Class: EA_felulet
Geometriai tipus: FELULET

Ennél az FC-nél kialakitott elem tipusok és a hozzdjuk kapcsolodd attributumok megfeleléek egy
térinformatikai adatbazishoz.

A feliileteket itt is felszabdaljak a vonalas elemek.

Az AL020 - belteriileti kozteriiletek esetében az egybefiiggd feliiletek Osszeflizésével meg kell
sziintetni azt, hogy az utak (egy vonalas) és az utcak felszabdaljak a feliiletet. Ami tartalmilag
egybetartozik, ssze kell vonni.

A részteriiletek Osszevonasat a konvertdlast kovetéen a GeoMedia megfeleld funkcidjaval lehet
elvégezni:

Edit > Feature > Merge
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5.2 EA_pont — Belteriileti kozteriiletek

Feature Class: EA_pont
Geometriai tipus: PONT

Ennél az FC-nél kialakitott elem tipusok és a hozzajuk kapcsolédé attributumok megfeleléek egy
térinformatikai adatbazishoz.

A véltoztatds nem sziikséges!

5.3 EB_felulet — Egyéb teriilet

Feature Class: EB_felulet
Geometriai tipus: FELULET

Ennél az FC-nél kialakitott elem tipusok €s a hozzajuk kapcsoldédd attributumok megfeleloek egy
térinformatikai adatbazishoz.

Az Osszefliggd feliileteket (azonos F_CODE esetén) szintén Ossze kell vonni, ha azokat egy vonalas
objektumok osztjak tobb részre.

A részteriiletek Osszevondsat a konvertdldst kovetden a GeoMedia megfeleld6 funkcidjaval lehet
elvégezni:
Edit > Feature > Merge

12



6 F — IPARI, MEZOGAZDASAGI, KOZLEKEDESI, KERESKEDELMI
UZEMEK és LETESITMENYEK

6.1 FA_felulet — Ipari, mezdgazdasagi, kézlekedési lizemi teriiletek

Feature Class: FA_felulet
Geometriai tipus: FELULET

Ennél az FC-nél kialakitott elem tipusok és a hozzajuk kapcsolédé attribitumok megfeleléek egy
térinformatikai adatbazishoz.

Az 6sszefiiggd feliileteket (azonos F_CODE esetén) szintén ossze kell vonni, ha azokat egy vonala
objektumok osztjék tobb részre.

A részterliletek Osszevonasat a konvertalast kdvetéen a GeoMedia megfelelé funkcidjaval lehet
elvégezni:

Edit - Feature > Merge
6.2 FB_vonal — Elektromos és tavkozlési vezetékek

Feature Class: FB_vonal
Geometriai tipus: VONAL

Ennél az FC-nél kialakitott elem tipusok és a hozzajuk kapcsoldédé attributumok megfeleléek egy
térinformatikai adatbazishoz.

Az vonalas elemeket Ossze kell fiizni. A folytonossaggal nincs gond, de feleslegesen allnak tébb
szakaszbdl. Ez a GeoMedia megfeleld funkcidjaval elvégezhetd automatikusan.

6.3 FB_pont — Elektromos vezetékek tartozékai

Feature Class: FB_pont
Geometriai tipus: PONT

Ennél az FC-nél kialakitott elem tipusok és a hozzajuk kapcsoldédd attribitumok megfeleléek egy
térinformatikai adatbazishoz.

A valtoztatas nem sziikséges!
6.4 FD_vonal — Termékvezetékek

Feature Class: FD_vonal
Geometriai tipus: VONAL

Ennél az FC-nél kialakitott elem tipusok és a hozzajuk kapcsol6dd attributumok megfeleléek egy
térinformatikai adatbazishoz.

Ebben az FC-ban a vonalas elemeket szintén 6ssze kell flizni. A folytonossaggal is idénként gond van,
és feleslegesen allnak t6bb szakaszbol.

Van ugy, hogy az Gtnal megszakad a termékvezeték (folytonossagi hiba). Ezekben az esetekben kézi
digitalizalassal 6ssze kell kotni, illetve a szakaszokat dsszefiizni egybe.



7 G — TERMESZETI EROFORRASOK
71 GA_felulet — Banyaszat

Feature Class: GA_felulet
Geometriai tipus: FELULET

Ennél az FC-nél kialakitott elem tipusok €s a hozzajuk kapcsolodd attributumok megfeleléek egy
térinformatikai adatbazishoz.

A valtoztatas nem sziikséges!

7.2 GA_pont — Banyaszat

Feature Class: GA_pont
Geometriai tipus: PONT

Ennél az FC-nél kialakitott elem tipusok és a hozzdjuk kapcsolodo attributumok megfeleléek egy
térinformatikai adatbazishoz.

A véltoztatas nem sziikséges!



8 H— VIZEK és VIZUGYI LETESITMENYEK
8.1 HA_felulet — Vizhalézat és tarolok

Feature Class: HA_felulet
Geometriai tipus: FELULET

Ennél az FC-nél kialakitott elem tipusok és a hozzdjuk kapcsolédd attribtitumok megfeleloek egy
térinformatikai adatbazishoz.

A feliileteket bizonyos esetben itt is felszabdaljak vonalas elemek. A minta szelvényen példaul a

kozigazgatasi hatar osztja tébb felé a Duna feliiletét. Az Osszetartozé (tartalmilag) faliileteket 6ssze
kell vonni.

A részteriiletek Osszevonasat a konvertalast kovetden a GeoMedia megfelelé funkcidjaval lehet
elvégezni:
Edit -> Feature - Merge

8.2 HA_vonal — Vizhalézat

Feature Class: HA_vonal
Geometriai tipus: VONAL

Ennél az FC-nél kialakitott elem tipusok és a hozzajuk kapcsolédd attribitumok megfeleléek egy
térinformatikai adatbazishoz.

A vizfolyasokat a hidak és az atereszek is megszakitjak. Ezeket a szakadasokat meg kell sziintetni,
hogy folytonosak legyenek.

Ezt a konvertalast kovetden a GeoMedia megfelel6 funkcidjaval lehet elvégezni:
Edit - Feature > Merge
8.3 HA_pont — Viznyerd helyek és tarolok

Feature Class: HA_pont
Geometriai tipus: PONT

Ennél az FC-nél kialakitott elem tipusok és a hozzajuk kapcsolédd attributumok megfeleléek egy

térinformatikai adatbazishoz.
A véltoztatas nem sziikséges!
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8.4 HB_felulet — Mitargyak

Feature Class: HB_felulet
Geometriai tipus: FELULET

Ennél az FC-nél kialakitott elem tipusok és a hozzajuk kapcsolédd attribitumok megfeleléek egy
térinformatikai adatbazishoz.

A valtoztatas nem sziikséges!

8.5 HB_vonal — Mitargyak

Feature Class: HB_vonal
Geometriai tipus: VONAL

Ennél az FC-nél kialakitott elem tipusok é€s a hozzajuk kapcsolédd attributumok megfeleldek egy
térinformatikai adatbazishoz.

A viéltoztatas nem szitkséges!

8.6 HB_pont — Miitargyak

Feature Class: HB_pont
Geometriai tipus: PONT

Ennél az FC-nél kialakitott elem tipusok és a hozzajuk kapcsolodd attribitumok megfeleloek egy
térinformatikai adatbazishoz.

A véltoztatas nem sziikséges!



9 | — NOVENYZET és TALAJNEMEK
9.1 IA_felulet — Erdok és fak

Feature Class: IA_felulet
Geometriai tipus: FELULET

Ennél az FC-nél kialakitott elem tipusok és a hozzajuk kapcsolodé attributumok megfeleldek egy
térinformatikai adatbazishoz.

A feliileteket az egy és két vonalas elemek|is felszabdaljak. Az egy vonalas elemek esetében meg kell
sziintetni a teriilet szabdaltsagat. Igy csak awemek és nvényzet valtas esetében lennének a
teriiletek elkiildnitve. o

~ A részteriiletek (tartalmilag Gsszetartozo) 6sszevonasat a konvertalast kvetéen a GeoMedia megfeleld
funkcidjaval lehet elvégezni:

Edit - Feature > Merge

9.2 I|A_vonal — Erddk és fak

Feature Class: IA_vonal
Geometriai tipus: VONAL

Ennél az FC-nél kialakitott elem tipusok és a hozzajuk kapcsolodé attribitumok megfeleloek egy
térinformatikai adatbazishoz.

A valtoztatas nem sziikséges!
A minta szelvény esetében ne tapasztaltam folytonosséagi problémaékat.

9.3 |A_pont — Erddk és fak, vizenyds teriiletek

Feature Class: IA_pont
Geometriai tipus: PONT

Ennél az FC-nél kialakitott elem tipusok €s a hozzajuk kapcsolddé attributumok megfeleloek egy

térinformatikai adatbazishoz.
A valtoztatas nem sziikséges!
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9.4 |B_felulet — Mezégazdasagi kultira

Feature Class: IB_felulet
Geometriai tipus: FELULET

Ennél az FC-nél kialakitott elem tipusok és a hozzajuk kapcsol6dé attributumok megfeleléek egy
térinformatikai adatbazishoz.

Jtt szintén az egy vonalase\keglg_k,_tﬁetébcmmq&lggy megsziintetni a teriiletek szabdaltsagat. igy csak a
kétvonalaselemek £s-névényaet valtds esetében lennének a tertiletek €lkiilonitve.

r?ﬁ?@temletek Osszevonasat a konvertalast kovetden a GeoMedia megfeleldé funkcidjaval lehet
elvégezni:
Edit -> Feature > Merge

9.5 IC_felulet — Vizi nyovényzet és mocsar

Feature Class: IC_felulet
Geometriai tipus: FELULET

Ennél az FC-nél kialakitott elem tipusok és a hozz&juk kapcsolddo attributumok megfeleldek egy

térinformatikai adatbazishoz.
A valtoztatas nem sziikséges!
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9.6 ID_felulet — Talajnemek

Feature Class: ID_felulet
Geometriai tipus: FELULET

Ennél az FC-nél kialakitott elem tipusok és a hozzdjuk kapcsolodo attribtumok megfeleléek egy
térinformatikai adatbazishoz.

_A feliiletek szabdaltsagat ennél az FC-nél is meg kell sziintetni. Csak a tartalmiklag sszetartozd
feliiletek legyenek egyben, a tobbi sszetartozo Toltot Ossze egyh masolni.

T S———— L T el T e

A részteriiletek Osszevonasat a konvertdlast kovetden a GeoMedia megfelelé funkci6javal lehet
elvégezni:
Edit -> Feature - Merge
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10 J — DOMBORZAT

10.1 JA_vonal — Szintvonal és mélységvonal

Feature Class: JA_vonal
Geometriai tipus: VONAL

Ennél az FC-nél kialakitott elem tipusok és a hozzajuk kapcsolédd attributumok megfeleldek egy
térinformatikai adatbazishoz.

A véltoztatas nem sziikséges!

Pillanatnyilag nem 4&ll rendelkezésiinkre szintvonal rajz, igy a konvertdlaskor ebbe az FC-be nem
kertiltek elemek. Abban az esetben, ha ez megtorténik, akkor az alap szabalyokon kiviil (szintvonalak
nem metszik, keresztezhetik egymast és az azonos értékkel rendelkez6 szintvonalak csak énmagukba
zarédhatnak) lényeges szempont, hogy a szintvonalak folytonosak legyenek és semmilyen egyéb
geometria ne szakitsa meg Oket (példaul a magassagi érték megiras, utak, stb.).

Abban az esetben, ha az esetleges konvertalaskor ez nem biztositott, akkor kézi digitalizalassal 6ssze
kell kotni a megszakadé szintvonalakat és Osszefiizni a GeoMedia megfelelé funkcibjaval a
vonalszakaszokat.

10.2 JB_felulet — Mesterséges és természetes domborzati elemek

Feature Class: JB_felulet
Geometriai tipus: FELULET

Ennél az FC-nél kialakitott elem tipusok és a hozzdjuk kapcsolodd attribitumok megfelelek egy
térinformatikai adatbazishoz.

A valtoztatas nem sziikséges!
A minta szelvénynél nem tapasztaltam, hogy a feliiletek fel lennének szabdalva.

10.3 JB_vonal — Mesterséges és természetes domborzati elemek

Feature Class: JB_vonal
Geometriai tipus: VONAL

Ennél az FC-nél kialakitott elem tipusok és a hozzdjuk kapcsolodd attribitumok megfeleléek egy
térinformatikai adatbazishoz.

A valtoztatas nem sziikséges!

10.4 JB_pont — Domborzati elemek

Feature Class: JB_pont
Geometriai tipus: PONT

Ennél az FC-nél kialakitott elem tipusok és a hozzajuk kapcsolédd attributumok megfeleléek egy

térinformatikai adatbazishoz.
A valtoztatas nem sziikséges!
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11 K — SZOVEG OBJEKTUMOK

11.1 KA_pont — Teriilet, domborzat névrajz

Feature Class: KA _pont
Geometriai tipus: PONT

Ez a struktura abbol a célbdl lett kialakitva, hogy a GVOP szdveges adattartalma egy az egyben
atkonvertalédjon a GeoMedi ald. A konverzi6é soran a GVOP elemkod tablazatiban felsorolt 8db
szOveges kategoridba lettek a text-ek athozva.

Ebben a formaban a térolds megoldott és kartografélas esetén is megoldott a feliratok megfeleld megjelenitése,
igy nem sziikséges a szerkezetet megvaltoztatni.
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12 L — KARTOGRAFIAI ELEMEK
12.1 LA_pont — Kartografiai cellak

Feature Class: LA_pont
Geometriai tipus: PONT

12.2 LA_vonal — Kartografiai vonalas elemek

Feature Class: LA_vonal
Geometriai tipus: VONAL

Az LA_pont és LA_vonal FC-k kialakit4sa azért valt sziikségessé, mert a GVOP elemkdd szerkezete a
kartografiai vonalas és pontszerii (celldk) elemeket Onalldan tartalmazza/tarolja. A konvertdlas utdn
létrejott szerkezetben ezek az elemek megtaldlhatéak az adatbazisban (GeoMedia), de szerepiik
elsésorban a kartografalt verzional van.

Vannak olyan elemek melyek a térinformatikai adatbazisbdl elhagyhatéak, mivel szerepiik kivalthato
mas modon.

Példaul: KLO03 (bels6 keret), KLL0O13 (KM halé) — ezeket a GeoMedia-val le lehet szerkeszteni.
KC020 (sz616), KC025 (temetd jel) — ezen feliileti elemek a hatarold vonaluk segitségével keriilnek
megadasra. Az F_CODE-juk egyértelmiien azonositja oket, a kit61to jeleket nem kell kiilon felvenni
egyenként. Kartografdlaskor a pattern konyvtarbdl vagy a cella kényvtarbol hozzarendelheté a
tertilethez a kitdlto jele.

Ezt azoknal az elemeknél kell alkalmazni, ahol az informaciét egy feliileti elem hordozza.

Ebben a két FC-ben vannak olyan elemek, melyeket a cella kényvtarban létre lehetne hozni és onnan
lerakni adott esetben, akar kitoltod jelként is felhaszndlva. Ilyen példaul a KLO10 (folyasirany). A cella

konyvtarban létrehozott elemeket ezekbdl az FC-kb6l torolni lehetne. Ertelemszeriien a pillanatnyi
formaban tarolt verzidjuk az adatbazisbol is torélve lennének.
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FELHASZNALOI KEZIKONYV

GVOPLoadDgn konvertal6 program hasznalatahoz
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1 Altalanos informaciok

Ez a technolégiai leirds részletes Utmutatast ad arrdl, hogy a MicroStation program alatt
elkészitett 1:10 000 meéretardnyt térképeket (dgn formatum), az e célra fejlesztett
GVOPLoadDgn programmal miként kell atkonvertalni GeoMedia ala (mdb formatumra).

A leirds pontos Gtmutatét ad arrdl, hogy milyen sorrendben, milyen beéllitisok és milyen
munkakdrnyezet mellett kell a konvertél6 programot futtatni.

A programmal parhuzamosan kialakitasra és elfogadasra keriilt a GVOP V3 struktirija. Ennek
részletes formdjat az elemkaod tablazat tartalmazza (Ditab V3 tablazat20090214.doc).

Figyelembe véve a MicroStation-ben meglévé struktirat (réteg/szin/geometria tipusa) és a
GeoMedia  ald  kialakitott  szerkezetet, elkésziilt a  megfeleltetési  tablazat
(Megfeleltetesi_tabla_20090214.xls). Ez a tablazat irja le, hogy a dgn fajlokban tarolt
geometriai elemek, mely Feature Class-ba keriilnek, milyen F_CODE ala és milyen kételezéen
feltdltendd attribGtummal a cél mdb-be.

A konvertald program ezzel a megfeleltetési tablazattal dolgozik.

A program futtatasakor a fejlécrél leolvashaté a konvertalé program aktuélis verzié szama.
A konvertaldé program indulé verzi6 szama: 1.0.

A program tovabbi fejlesztése €s modositasa ezen keresztiil nyomon kovethet6.
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2 A GeoMedia telepitéséhez sziikséges beallitasok

- A konvertald program (GVOPLoadDgn.exe) a GeoMedia Pro 6 verzi6 alatt futtathato.

- A GeoMedia Pro 6 telepitése elbtt az adott szamitégépen a kdvetkezd bedllitdsokat kell
elvégezni:

2.1 Konfiguracié
A konvertal6 program a kdvetkezd hardver és szoftver kdrnyezetben lett tesztelve:
- Intel Pentium 4 CPU 2,80 GHz
- Matrox Millennium G550
-1 GB RAM
- Windows XP Service Pack 3 (verzio: 20080414.052803)
- MicroSoft NET FRAMEWORK2.0 Service Pack 1

2.2 Terliileti beallitasok

A GeoMedia telepitése elott kotelezd a teriileti beallitdsok atéllitasa.
=> Start menii -> Beallitisok -> Vezérlgpult -> Teriileti beallitisok -> ANGOL

Tesulel bedfitasok | Npelvek | Speciais

Szabvingok és formdtumok

Ez a beéllitas befolyssolia, hogyan jelennek meg a s2zdmok,
pénzegységek. idGpontok és détumok az egyes programokban.

Sz6m [123456,789.00
Pénzem  [$123456.783.00
I5: 327.02AM

Rowd détum: | 2/25/2009
Hoss2i ddtum: | \wednesday. February 25, 2009

Foldrazt hely

Itt bedBithatia a jelenleg: tatéekodas halyét, igy a szolgaitatisok
konnyebben tudnak hely mformécidkkal s2olgalni (pl. hirek, dBjarés):
| Magyarorszig A4

Lok J[ Mégse || Akamaz |
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> Ezt kovetben lehet telepiteni a GeoMedia Pro 6 programot. A konvertalé program
tesztelése a kovetkezd feltelepitett HotFix-el tortént.
A konvertalé program hasznélatdhoz ezt a HotFix-et vagy ennél frissebbet kell hasznalni.

About GeoMedia Professional

ergraph Corporation

wWarning, This computer program is
protected by copyright law end

- international tresties. Unauthorized
o reproduction or distribution of this
program, or any portion of this
program, may result in severe civil
and criminal penalties, and will be

System Info

ili

-> A program telepitését kivetGen a teriileti beallitast vissza kell allitani magyarra
Start menii -> Beallitasok -> Vezérlopult -> Teriileti beallitasok -> MAGYAR

2.3 Billentylizet beallitasok

Start menii -> Beallitasok -> Vezérlopult -> Billentyiizet -> Billentyiizet nyelve

llent yuizet tulajdonsagai 3 o i

Sebesség Bientylizet ryeive | Hardve |

— Telepitett npelvek
(I HU[REEIE

Bientyi‘aeﬂtmztas/lrawbevm

Angol [amenkal]

Hozzéodés. |  Emévolités |  Tulaidonssgok.. |

_ Hepéteinezet |

erileti beallitasok

Altalénos | Szamok | Pénznem | 106 | Détum | Bisentyiizet nyetve |

- Jelenlegi felhaszanélé besllitésai
Szén::s program felhasznélia a kulonboz8 tertiet bedllitasokat (szam-,
détumformétumok,

nemzeti szabv&\yoknak megfelelt tarulet: baallitast,
2 itas:

pénznemek). Valassza ki a hasznéini kivént

IAIapérlelmezell
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3 A sziikkséges munkakornyezet kialakitasa
3.1 Konyvtar struktara kialakitasa és a sziikséges fajlok elhelyezése

=> D:\Konvertal\65-213\... € a konvertalandé dgn fajlok
- 65-213 fel.dgn
- 65-213_jk.dgn
- 65-213_keret.dgn

A d:\Konvertal kényvtarba kell a szelvény nevével létrehozni az alkdnyvtarat és ebbe kell
bemasolni a szelvényhez tartoz6 3 db design fajlt. Az alkdnyvtar nevének pontos megadasa
azért fontos, mert a program ebbdl képzi a cél adatbazis fajl nevét.

Arra is van lehetdség, hogy egyszerre tSbb szelvényt helyezziink el a d:\Konvertal
konyvtarban, mivel a konvertalandé szelvényt a program inditisat kovetden kell
kivalasztani.

-> D:\Konvertal\Program\... € a program futtatisahoz sziikséges fajlok
- GVOPLoadDgn.exe € konvertdlé program
- GVOP.mdt € cél adatbazis (template)
- gvop.csd € Cad Setup Server fajl
- gvop.csf € vetiileti fajl
- gvop.ini € a csd fajl beéllitdsahoz

A d:\Konvertal konyvtarba kell létrehozni a Program alkonyvtarat. Ide kell bemdasolni a
fentiekben felsorolt 5 db fajlt. A programot innen kell futtatni. A program ebbd6l a konyvarbol
veszi automatikusan a sziikséges fajlokat (csd, csf, mdt, ini).
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4 A GVOPLoadDgn konvertalé program hasznalata

4.1 A konvertalé program futtatasa

> Inditsuk el a GVOPLoadDgn.exe-t

Betsltendé DGN fajlok:
> B comb segitségével vélasszuk ki azt az alkonyvtarat, ahol az atkonvertalandé
szelvény design fajljai vannak.
Amennyiben kivalasztottuk, akkor kilistdzza az alkdnyvtar tartalmat a ,Bettltendé DGN f4jlok”
ablakban. Itt van lehetdségiink, hogy a jeldlést kivegyiik/visszarakjuk a fajlok el6l.

Eredmény fajlok:
=> Konvertélas eredménye: D:\Konvertal\<szelvényszdm>\<szelvényszdm>.mdb

A program automatikusan a Program alkonyvtarban elhelyezett GVOP.mdt fjlbol hozza létre
a cél adatbazist (<szelvényszdm>.mdb), abban az alknyvtarban, ahol a design fajlok vannak
és azzal a névvel, ami az alkonyvtar neve. A példaban: 65-213.mdb.

=> Hibas, nem betslthetd elemek: D:\Konvertal\65-213_hiba.mdb
- Opciondlis, nem kotelezd kivalasztani.
- Alapban a design fajlok alkdnyvtarat ajanlja fel, a szelvény (=alk6nyvtar) nevével
(pl.: 65-213_hiba.mdb). Mindezek megvaltoztathatoak.
- A <szelvényszam>_hiba.mdb fajl a GeoMedia Pro 6 programmal megtekinthetd.

> B

& GVOP Dgn fajlok betoltése 1.6

i & | 0
| oonfigok | st

Betakendd DGN talok
[@] 65-213_feldgn

65213k don
{v] 65-213_keret.dgn

Eredmény (&ok
Konverlalas eredménye. D: \Kmld\55213\65-21 3 mdb :

[#] Hibés. nem belolthatd elemek. | D \Konverta\85-213\65.213_hiba mdb

00

Végrehatés | Hializenetek | Statsztika | Konverzios tébla|
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4.2 A konverziés program lizenetei

4.2.1 Végrehajtas fiil: a program altal végrehajtott Iépések (eredmény mdb, csd, dgn

alloményok betsltése)

4.2.2 Hibaiizenetek: a konverzid soran el6fordulé hibak felsorolasa
A kovetkezo hibaiizenetek jelenhetnek meg:

Ssz. Hibaiizenet Hibaiizenet jelentése
1. | A *.csf fijl nem talilhaté. Hianyzik az adott konyvtarbdl a *.csf fajl.
2. | A *.csd fijl nem taldlhaté. Hiédnyzik az adott kényvtarbol a *.csd fajl.
3. | A * fijl mar létezik. Feliilirhat6? Ezen a néven, mar létezik fajl. A feliiliras engedélyezése.
4 A hibds elemeket tartalmazé fajl nincs | A Hibas, nem betSlthetd elemek opci6 bejelslve, de nincs fajl név
’ megadva. megadva.
5. | .. réteg szim hibas ... objektumnal 1-63-ig lehetséges a réteg szam, egyébként hiba.
6. ... szin hibads ... objektumnal 0-255-ig lehetséges a szin kod, egyébként hiba.
7. ?ellanev h osszabb 6 karakternél ... Az adott elemnél a cella neve 6 karakternél tsbb, hiba.
objektumnal
8 Adatbazis neve nincs megadva ... Nincs megadva a megfeleltetési tablazatban, hogy melyik adatbazisba
* | objektumnal konvertalja a program az adott elemet. Javitas: programozé.
9 Feature class neve nincs megadva ... Nincs megadva a megfeleltetési tablazatban, hogy melyik Feature
* | objektumnil Class-ba konvertalja a program az adott elemet. Javitas: programozo.
F_CODE értéke nincs megadva ... o s .
10. objektumnsl Hianyzik az F_CODE. Javitas: programozd.
11. | Hiba a GVOP_V3.mdb megnyitisdndl | A cél adatbazist nem tudja a program megnyitni.
12 A(z) ... tabliban nincs geometria mezé | A cél adatbazisban hianyzik/hibas a geometriat fogadé mez6. A
* | a(z) ... adatbazisban template fajlbol ujra kell késziteni.
13 A(z) ... tabla nincs a(z) ... Olyan Feature Class-ba szeretnénk konvertalni az adott elemet,
* | adatbdzisban amilyet a cél adatbézis nem tartalmaz. Javitas: programozo.
A program ellenérzi a design fajlban az elem
14. | A rajzelemet a program nem tolti 4t szerkezetét/geometriajat. Amennyiben nem megfelel8, akkor nem
tolti at. PL.: 3D-s elem.
15. | Hibss attribitum érték: ... }los'g e.lttrlbutum er’tek van a megfeleltetési tdblazatban megadva.
avitds: programozd.
,. . Az adott attribitum mez6 nem létezik. Javitas a cél adatbazisban,
16. | ... mezé nem taldlhaté . S M
felvéve a hianyzé mezdt vagy a programban.
17. | Hibés attribfitum mezé: ... JAz ’at'tr.lbutum ertek’ megadasakor elkdvetett szintaktikai hiba.
avitas: programozd.
18. | Geometria hidnyzik Nem rendelkezik geometriaval. Hiba a design fajlban van.
. A rajz elemet (szin, réteg, cella név alapjan) a program nem tudja a
19. Rajzelem nem sorolhatd be feature megfeleltetési tabla szerint besorolni. Hibés az elem a design fajlban
class-ba L (.
vagy a megfeleltetési tablazatban van az eltérés.
20. | Hiba a ... adatbizis irdsa kézben Az ‘ad’ott‘elemet hiba miatt a hibalistiba kellene irnia, de oda sem
tudja irni.
21. | A téblsban egyetlen rajzelem sincs A design f4jlbol nem jott at egyetlen elem sem, ezt jelzi gy, mintha

tires lenne a dgn.

4.2.3 Statisztika: megmutatja, hogy az adott elembdl hany darab lett atkonvertilva a
megfeleltetési tdblazat szabalyai alapjan

4.2.4 Konverzios tabla: A megfeleltetési tablazatot listdzza ki
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4.3 A konverziés program lizeneteinek mentése

<> Nyomjuk meg a [Jlll gombot és adjuk meg a fajl nevét (pl.: 65-213Ment)

Opcionalis, mentés nélkiil is kiléphetiink, de ez esetben az iizeneteket mar csak akkor tudjuk
megnézni, ha 0jbol lefuttatjuk a konverzidt az adott szelvényre.

Mentés esetén, az igy keletkez6 mdb allomanyt az Access program segitségével tudjuk
megnézni. Itt is alapban azt az alkdnyvtarat ajanlja fel, ahol a design fajlok vannak. A név
szabadon megadhatd. Pl.: 65-213_ment.mdb

A statisztika, lizenetek és végrehajtds tablak tartalmazzak az el6zé pontban felsorolt
tizeneteket. Kivétel a konverzids tabla

Ezekre a tablakra kattintva lehet megnézni tartalmukat.

m 65 211 _Ment : adathazis {Access 7000 fajlformatum)
I = Tablsk Bl Tablalétrehozésa varszsls seghségével
B Lekirdezéset &) Tabla létrehozésa adatok beirsaval
3 6 O GalasTable
Seisbck TJ  GCoordSystem |
@ Jelentések 1 GSQLOperatorTable |
93 Lapok 53 ModificationLog
2 Makesk i
=
| -Modjok__ S0 o
B a
| B Kedvencek

- Végiil zarjuk be a konverziés programot: [l

4.4 A konverzié soran keletkezé eredmény allomanyok

> <szelvényszam>.mdb € ebbe a fajlba konvertalta 4t a design f4jl tartalmat a program

A példanél maradva: 65-213.mdb

> <szelvényszdm>_hiba.mdb € a hibas, nem betdlthetd elemek keriilnek ebbe az mdb-be.
A GeoMedia Pro 6 segitségével megtekinthet a tartalma. Opciondlis.

A példanal maradva: 65-213_hiba.mdb

> <szelvényszém>_ment.mdb € a konverziés program iizeneteit tartalmazza. Az Access
segitségével listazhatunk ki 4 tizenetbdl 3-at. Opcionalis.

A példandl maradva: 65-213_ment.mdb
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FELHASZNAILOI KEZIKONYV

GVOP adatszolgaltatasi program hasznalatdhoz
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1 Bevezetés

Jelen technoldgiai utasitas rendelkezik az uthaldzathoz tartozd elemek és a kozteriiletekhez
sorolt utcak szerkezeti atalakitasarol.

Feliilet tipust Feature Class-ok:
Az 1thalozathoz tartozé Feature Class-ok koziil a feliilet tipustiakon kell szerkezeti
valtoztatdst végezni. Vannak bizonyos vonalas elemek, melyek felszabdaljak a feliileteket.

Ezeket a tartalmilag egybe tartozd foltokat kell egybemaésolni, megsziintetve a feldarabolt
allapotot.

A fenti kivagaton lathato két elkiilonitett szinnel, hogy az adott utszakaszt (feltilet tipusu)
kettévagja a vasut nyomvonala (vonalas tipusa). Tartalmilag/térinformatikailag nem indokolt,
hogy kettéosztja, ezért az ilyen jellegii ,.hibdkat™ kell megsziintetni.

Vonalas tipusu Feature Class-ok:
Minden vonalas elemnél biztositani kell, hogy folytonos legyen. Semmi nemii kartografiai

elem (megirasok, jelkulcsi jelek, stb.) ne szakitsa meg 6ket. Szakadas esetén ezeket
osszekotéssel meg kell sziintetni!

A sziikséges atalakitasok a 65-213 nomenklatiraji szelvény segitségével keriilnek
bemutatasra.



2 Adatbazis megnyitasa
2.1 Munkakdérnyezet kialakitasa

Maésoljuk a sziikséges alapanyagokat a Warehouse konyvtarban az erre a célra kialakitott
alkdnyvtaraba.

> 65-213.mdb
> 65-213_t_1997_cw_tk.tif
> 65-213_t 1997 cw_tk.tfw

2.2 Inditsuk el a GeoMedia-t

- Vilasszuk ki a

- GeoWorkspace template-t
- Vilasszuk a Normal-t - > New
- Ellenérizziik a koordinatarendszert (EOV_mm.csf)

2.3 Adatbazis megnyitasa

- Warehouse > New Connection (Access)
= 65-213.mdb allomanyt csatoljuk.
-> Jelenitsiik meg a csatolt adatbazisunkat:
Legend - Add Feature Class (az osszes FC-t jeldljiik ki.

A térképi kinézet (szin, kit61t6 szin, vonal vastagsag) mindig az aktualis feladathoz
igazitandé az egyéni igények/szokasok alapjan. Igy ezek részletes leirasra nem keriilnek.

2.4 Munkakdrnyezet mentése

A megfelel6 beallitdsokat kovetéen mentsiik el a munkakornyezetiinket.
File - Save GeoWorkspace As...
Hova: Sajat gépen a GeoWorkspace kényvtarba
Milyen néven: pl.: 65-222.gws



3 A GeoTiff allomanyok behivasa (amennyiben sziikséges)

Warehouse = New Warehhouse = normal

neve: 65-213 raszter.mdb

Ebbe az adattarhazba fogjuk a sziikséges rasztereket behozni.

Ezt az adattarhazat a raszter miatt hoztuk létre. Mivel ehhez csatoljuk hozza a raszter fajlunkat,
elkerilljik azt, hogy az éles adatbazishoz valo csatolds esetén ,rajta” hagyjuk a munka végén a

rasztert.

Insert - Georeferenced Images

Be kell allitani a georeferalds modjat: World file € tfw esetében
A helyet, ahol a raszterek vannak: warehouses\...

Koordinatarendszer: EOV.csf

At kell helyezni a nyil segitségével a sziikséges rasztereket balrol jobbra

Meg kell adni, hogy mely adattarhdzba szeretnénk rakni a kivélasztott rasztereket:
65-213_raszter

Végiil adni kell egy tetszéleges nevet (pl.: raszter)

insert Georeferenced images r)ﬂ

Georeference mode: LCootdinate system file:

{World fie | [D\Warehouses\Vetuletek\EQV. csf Browse. |
Selected images

Foider. [ \Warehouses\GVOPY Blowse...
Extensions: I"'

Ayailable fies: Selected fles:

65-213.ldb 65-213_t_1997_cw_tk tif

65-213.mdb

65-213_raszter.ldb

65-213_raszter.mdb

65-213 t 1397 cw_tk tfw
65-213kait. mdb

Lo

» I

gvkopdéfy&haty mdb q |
<< l

Insert images into

Warehouse: r
|65:213_raszter ~|

[Eeatue classes with matching coordinate system:

Jrasztes K| [—EIK_I o Apok l




4 D — KOZLEKEDES

4.1 DA_felulet — Kozlekedési létesitmények

Ennél az Feature Class-ndl is feladat a feliiletek §sszevonasa. Az utak feliiletét felszabdaljak a vonalas
objektumok és a feliileti objektumként lerakott hid objektumok.

B i

A fenti kivagaton, ahol taldlkoznak az utak, t6bb darabboél allnak. Illetve a bevezetdben is mutatott
példahoz hasonléan az ut feliiletét kettéosztja a vasit nyomvonala.

Az ut feliilet darabjait ezekben az esetekben is 6ssze kell vonni.

Az 6sszevonasndl a TUC attributum mez6t kell figyelembe venni, mivel a konvertalaskor ez keriilt
értékes adatokkal feltSltve. Az t tipusokat kiiléniti el (151, 152, 153, 154, 155, 158). Az ut feliiletek
Osszevonasanal csak azonos TUC értékkel rendelkez6 foltokat vonjunk 8ssze.

-> Jelenitsiik meg a TUC mez6t egy lekérdezéssel: Insert - Label

tnserd | abel x

Lapel featutes n Output labels as
[& s52130A_tedet =] © Que © Featym class
Query name:
Content |Labels of DA_ehdet)
Atinkes e
S_NAME -
fi’? 2l
Layout: [Cii+Enter for new ine) ™ Enable loadey fnes
UG Ak
] =
Cuentation: IPlauedmde vl ID.U dag
Algrment: | Center center =] |
I Offsett " byl_ I——'——j Dwuhmm
Map window name: St
™ Offset yerhcaly by | '| IMamedowl .|
= - 4
_Goncn |




-> A shift billentyt segitségével jeldljiik ki a tartalmilag (TUC) 6sszetartozo feliilet darabokat
- Edit - Feature > Merge

Az utfeliiletek 8sszevonasat ugy kell elvégezni, hogy az adott lapon 4thalado ut (azonos TUC
attributummal rendelkez6) kiilon all6 darabjai legyenek 6sszemasolva, mig a betorkol6 utakat ne
masoljuk hozza.

Ezeknél az utaknal is csak akkor alkalmazzuk a Merge funkcidt, ha ket osztja tobb fele egyéb elem.

Ut-hid talalkozésa esetében:
A DA_felulet és DC_felulet FC-ket kell megjeleniteni a térkép ablakban.

A kovetkez6 példa az 1t €s hid kapcsolatat mutatja be. A feliiletként dbrazolt Gt megszakad, ha hiddal
kertil kapcsolatba. A hid szintén feliiletként van dbrazolva, de t6bb darabbdl all.

- A meglévo szerkezet (utak feliileti Abrazolasa) esetében elvégzend6 atalakitasok:
A DA_felulet FC-on biztositani kell az utfeliiletek folytonossagat.

Ehhez a hid két oldalan 1év6 utfeliiletet 6ssze kell kotni, Ggy hogy egy feliiletet képezzenek.
- Csak a DA _felulet maradjon megjelenitve,
-> Jeloljiik ki a hid egyik oldalan 1évé utszakaszt

-> Az Edit Geometry gomb NT segitségével jelenitsiik meg a feliilet téréspontjait.

-> Majd a megfelel6 téréspontokat mozgassuk ra a szemkozti toréspontokra a megfeleld Snap
funkcid hasznalataval.

-> Miutén folytonossa valt a feliiletiink, masoljuk egybe a két szakaszt:
Edit > Feature > Merge



A hid feliileti dbrazoldsa is megmarad, de a 3-6 részbdl 4116 részeket szintén dssze kell masolni egy
feliiletté. A DC_felulet FC-t is jelenitsiik meg a térkép ablakunkban.

- Jeloljiik ki az osszetartozo hid darabokat, majd
- Edit <> Feature > Merge

4.2 DA_vonal — Kozlekedési létesitmények

-> A vonalas tipusu uthalézat felvétele.

Térinformatikai szempontb6l azokat az utakat, melyek feliiletként vannak 4brazolva, fel kell venni
tengelyvonalukkal ebbe a Feature Class-ba.

DA_vonal Feature Class-ban a meglévé AP030-as kod alatt kell az tittengelyek digitalizalasat
elvégezni.

Az elemkéd tablazat TUC attributumat ki kell egésziteni:
- 151 Autopdlya
- 152 Auto6iit, korszeri miint
- 153 Miiat
- 154 Javitott talajut
- 130 Utca
- 806 Gyalogosan jarhaté utca
- 807 Diszkertek, parkok, gyiimélcsdsok utja

> A digitalizélas soran ezeket az értékeket kell az attribtitum tablézat TUC mezjébe beirni, annak
fliggvényében, hogy melyik feliileti elem kézépvonalat raktuk le.

Az utak, utcak digitalizalasét a feliiletek kdzépvonalanak figyelembevételével kell elvégezni.



> Készitsiink egy tematikus levalogatast a DA felulet FC-re, hogy a TUC mez6 alapjan
elkiilonitsiik az utakat.

-> Legend - Add Thematic Legend Entry
Input Feature: DA_felulet
Type: Unique Value Thematic
Thematic Classes: TUC

- Classify 2 OK

Vale Lobel Court
15 115 [
1§ 83 1=
154 154 P
% 155 - i
< » - —
=
I~ Show count as percent
(o] s |

- Készitsiink egy tematikus levalogatast a EA felulet FC-re, hogy a USE mez6 alapjan
elkiilonitsiik az utakat.

- Legend - Add Thematic Legend Entry
Input Feature: EA_felulet
Type: Unique Value Thematic
Thematic Classes: USE

= Classify 2 OK
|8 S5213EA febdet = |
Ty Themake classes Thematc styles
Strded Aprbue for classlicaton
o 3| e ]
Classly | 7 Assgn colors
| e v e =

Csak erre a hdrom fipusra (USE=130, 806, 807)!



=> Insert Feature gomb
-> Feature Class kivalasztasa (DA_vonal)

-> A két tematikus lekérdezés (DA_felulet, EA_felulet ) alapjan a nyomvonalénak
digitalizalasa a k6zépvonallal.
-> Attribuitum tabla kitoltése

DA_vonal Properties X

4 TUC=az 1t tipusa (1asd fentebb)
General Attibutes | i / S_DATE=digitalizalas napja

" IName Value 4
F_CODE_ LFWZ“ 7
Bt - - —1$ - __

3 933

-> A digitalizalasndl célszerii a Continue Geometry gombot hasznélni, ha valtozatlan
attribitum értékekkel akarunk elemet digitalizalni.

- A digitalizalasnal a bek&to utak téréspontban csatlakozzanak egymashoz.

- A pillanatnyilag vonalas elemtipussal bedigitalizalt vonalszakaszok végpontjait is be kell
kotni a vonal tipusi 1t téréspontjaba.

> A meglévd egyvonalas utakndl is §ssze kell kotni azokat a szakaszokat, amelyeket a hidak,
atereszek €s megirasok szétszabdalnak és€zaltal nem folytonosak.

Ennél a példandl az ut adat szakitja meg az ut tengelyét.
A Continue Geometry funkcidval tudjuk megsziintetni a
szakadast.




4.3 DA_pont — Kozlekedés létesitmények

Ennél az FC-nél kialakitott elem tipusok és a hozzajuk kapcsolodé attribitumok megfeleloek egy
térinformatikai adatbazishoz.

Szerkezeti 4talakitas nem sziikséges!

4.4 DB_vonal — Vasiit, drétkotélpalya

Ennél az FC-nél szerkezet atalakitdsra nincs sziikség. Az ellenérzést (vizudlis) csak arra kell
kiterjeszteni, hogy a vasut és drotkotélpalydk nyomvonalat ne szakitsak meg egyéb kartografiai
elemek. Biztositani kell a folytonosségukat.

Osszekell kétni a két végpontot, hogfool.ytonos le.gyen a nyomvonal.
A Continue Geometry funkcioval.
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4.5 DB_pont — Vasiit

Ennél az FC-nél kialakitott elem tipusok €s a hozzajuk kapcsolodd attribitumok megfeleloek egy
térinformatikai adatbazishoz.

Szerkezeti atalakitas nem sziikséges!

Egy lekérdezés segitségével ellendrizni kell, hogy a vastthoz tartozé pontszerii elemek (DB_pont)
rajta vannak-e a vasut vonal tipusu elemén (DB_vonal).

- Tools > Validate Connectivity

Vahdate Connectivily

Validate connectivity between

Eeatues in: Features in:
| A~ 65-213DB_vonai ¥} And |« 85213DB_pont Iz
Options Output results as query
Find Guery name:
W Undershoots IDB_vonaI and DB_pont connectivity probl
™ Qvershoots Y
I Node mi ' Descnplion

I Unbroken intersecting geometty
™ Non-goincident intetsecting geometry
™ Nearly concident geometry

Tolerance: |10 |m '1
@ Displag resuls in map window ™ Display rgsultsin data window
Map vandow name: Style
[Mapwindowl -l < | =l

- A DB_pont FC-t vizsgalni kell (Validate Connectivity) a DB_vonal esetében.

-2 A megjel6lt elemeket (lekérdezés) meg kell vizsgalni. Amely pontokat sziikséges, ra kell
mozgatni a vonalas elemre.

4.6 DC_felulet — Hidak, atkelSk

A feliilet tipusu hidak szerkezete egy korabbi pontban (4.1) annyi valtoztatason atestek, hogy a 3-6
darabbdl 4ll6 részek egybe lettek masolva. Egyéb valtoztatas nem sziikséges.



4.7 DC_vonal — Hidak, atkelék

Amennyiben a feliileti objektumként tarolt uthalozat bedigitalizalasra keriil a vonalas tipusi FC-be
(4.2 pont), vagyis kiegészitésre keriil a vonalas uithalézat, sziikséges a hidak digitalizalasa vonalas

tipust FC-be.

Létre kell hozni egy kiilén FC kdédot a vonalas hidakra: AQ050.
A feliilet tipust hidak tengelyvonalat kell bedigitalizalni, igy hogy a hid nyomvonala egybe essen a

korabban bedigitalizalt vonalas tipust uttengellyel.
-> Insert Feature gomb
-> Feature Class kivalasztasa (DA_felulet)
- Kapcsoljuk be a vonalkvetd funkciot:

Ezt a funkciét kell bekapcsolni, amikor meglévd vonalszakaszt/felillet egy szakaszat
szeretnénk felhasznalni egy 0j elem digitalizalasakor, oly médon, hogy ezek k6z6s szakaszok
legyenek. Ezzel a moddszerrel lehet elérni, hogy az egymés mellett 1évé elemek ne
fedjék/metsszék egymast és hézag se legyen koztik. A jelolés megsziintetésével lehet a
funkciét kikapcsolni. Ez a funkcid az ikonok kéziil is elérheto.

Genetall
File Locations 2

‘When snapping

Tools -> Options... -> Placement and Editing fiil

- Use existing geometry when digitizing

Stream tolerances

¥ Mantan concidence Distance:
™ Segment arcs when inserting vertex f Im 'l
[~ Break inear features Deha:
(r |10 Im 'l
e
[~ Lsm deeu hegh yalus instead o + Updo
= height at snap point during placement [ Lini undo operatons
Automatically add legend entnes
Numbeg: |
¥ Copy attrbute values rom previous feature :
[ Defaut heght value
]0 m
Default drechon type
Azimuth -
0K ] Concel |




4.8 DC_pont — Hidak, atkel6k

Amennyiben a feliileti objektumként tarolt withalézat bedigitalizalasra keriil a vonalas tipusu FC-be
(4.2 pont), akkor az atereszeket, melyek most két ponttal vannak rogzitve az adatbazisban (az 1t két
szélén vannak a beszurasi pontok), az uttengelyre kell digitalizalni (egy darab beszirasi ponttal).

-> Fel kell venni ebbe a Feature Class-ba egy elemet: AQ080.

-> Végig kell nézni az atereszeket és azok esetében, ahol dupla besztirasi ponttal lettek felvéve,

be kell digitalizdlni egy darab beszurasi ponttal, amely illeszkedik a vonalas elem
tengelyvonalara.

-> Amennyiben eredetileg is egy beszlrasi ponttal lett lerakva az ateresz, akkor ellendrizni
kell, hogy ezek a pontok rajta vannak-e a hozzajuk tartozé vonalas elemen.

=> Tools = Validate Connectivity

Vahdale Connectivity
Validate connectivity between
Eeatwes n: Featutes n:
| A~ 65213DA_vonal 7} And | 65213DC_pont 3
Opbons Output results as query
Find Query name:
' Undershoots JDA_vonal and DC_pont connecivity probl
¥ Qvesshoots Desci
T Node mismatches esenaor:

¥ Display results in map window [~ Display 1asuks in data window!
Map window name. Style:

o ac il e 3

[ ok | Cance |

- A DC_pont FC-t vizsgalni kell (Validate Connectivity) a DA_vonal és DB_vonal esetében is.

- A megjeldlt elemeket (lekérdezés) meg kell vizsgalni. Amely pontokat sziikséges, ra kell
mozgatni a vonalas elemre.

13
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1 Bevezetés

Jelen technoldgiai utasitas rendelkezik a vizrajzhoz tartozé elemek szerkezeti atalakitasarol.

Feliilet tipust Feature Class-ok:

A vizrajzhoz tartozé Feature Class-ok koziil a feliilet tipusuiakon kell szerkezeti valtoztatast
végezni. Vannak bizonyos vonalas elemek, melyek felszabdaljdk a feliileteket. Ezeket a
tartalmilag egybe tartoz6 foltokat kell egybemasolni, megsziintetve a feldarabolt allapotot.

A fenti kivagaton lathaté harom elkiilonitett szinnel, hogy ennek a folydszakasznak a feliilete
fel van darabolva. A feliilet darabok a kézigazgatasi hatarok mentén vannak kialakitva, de
térinformatikai szempontbol ez sziikségtelen. Abban az esetben, ha az adott feliilet tartalmilag
Osszetartozik, akkor mas elemekkel nem kell megszakitani, feldarabolni.

Vonalas tipusu Feature Class-ok:

Minden vonalas elemnél biztositani kell, hogy folytonos legyen. Semmi nemii kartografiai
elem (megirasok, jelkulcsi jelek, stbh.) ne szakitsa meg 6ket. Szakadas esetén ezeket
osszekotéssel meg kell sziintetni!

A sziikséges atalakitisok a 65-213 ndmenklaturaju szelvény segitségével keriilnek
bemutatasra.
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DTA10 V3

Objektum-attribiitum katalogus €s adatfeltoltési utasitas

ALKALMAZOTT JELOLESEK
ADATTIPUSOK
Jeldlés Adattipus lefrdsa Hossza

Text (n) | Széveg n karakter
Double Lebeg6pontos szdm 8 byte (64 bit)
Long Hosszu egész szam (el6jeles) 4 byte (32 bit)
Integer

Integer Egész szam (elbjeles) 2 byte (16 bit)
Date Datum (EEEEHHNN) 8 byte (64 bit)

wlsmeretlen” . Kitiltetlen” és .,Nem jellemz6™ ..Egyéb” kédok kiilonbozd tipusai

Attriblitum tipusa Ismeretlen Kitbltetlen Nem jellemz6 Egyéb
Integer 0 997 998 999
Déatum D) 2000.01.01. 1900.01.01. - -
Szdveg ' ,,UNK” »N_P” »N_A” ,,Other”
Egész szam (Integer, Long Integer) -32767 -32766 -32765 -32764
Lebegdpontos szam (Double) -32767,0 -32766,0 -32765,0 -32764,0
A DTA10 V3 objektum szintii metaadatai
Valamennyi objektumhoz kotelezéen hozza kell rendelni a kdvetkez6 attributumokat:
Oszlop Leiras Erték Jelentés Adattipus
STC Adatforras tipusa 1 Terepi felmérés Integer
2 Sztere6 foté -
3 Mono foté (onofot5 -
4 Kartografiai forras
998 Nem jellemz6 i
999 Egyéb
KSH KSH kéd Integer
S_NAME | Adatforrds megnevezése |Széveg Az adatforrds megnevezése a térzskonyvben
rogzitendd rovid megnevezéssel, Text (50)
"UNK” Ismeretlen
S _DATE Adatforrds datuma YYYYMMDD A geometriai adatfeltoltéshez felhaszndlt
adatforrds érvényességi ddtuma, Date
"UNK" Ismeretlen
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DTAI10 V3 Objektum-attribitum katalégus és adatfeltdltési utasitas

1 A-ALAP-ES HATARPONTOK

1.1 AA_pont — Alappontok

Feature Class: AA_pont
Geometriai tipus: PONT
Oszlop Leirés Erték Jelentés Adattipus
1. |ID A tablazat soranak azonositdja | 1,2,3,....... Autonumber
2. [F_CODE |Objektumkadd ZB060 | Vizszintes alappont Text (5)
ZB020 | Magassdgi alappont
ZB030 | Hatdrpont
3. |NA3 Classification Name Széveg | Pont megnevezése Text (80)
(sorszdma a pontjegyzékben),
"UNK” [ Ismeretlen
4. [NAM Név Szbveg | Pont megnevezése (dllami jelolés), Text (80)
(ZB030, ZB060, ZB020) "UNK” [ Ismeretlen,
”N_A” | Nem jellemz6
5. | PFT Allandésitasi méd 1 K6 Integer
2 Tércsa
3 Csap o
4 Gomb
5 Védmii
6 Templomtorony
7 Egyéb torony
8 Mérétorony
9 Kémény
10 Viztorony
11 Vasszekrény
6. | TIPUS Tipus (ZB060, ZB020) 1 OGPSH alappont Integer
2 Csillagészati alappont
8 Templomtorony haromszdgelt
12 T4jékoztatépont, Orpont, hatérjel
13 Templomtorony h.szégelt (alapr-nem)
18 Szintezési féalappont
20 Fliggdleges foldkéregmozgdsi alappont
21 EOVA pont
998 Nem jellemz6
7. |EXS Allapot (ZB060, ZB020) 0 Ismeretlen Integer
1 Meglévd (ép pont)
2 Kérdéses (a pont nem talalhatd)
6 Szétszedett
7 Elpusztult
33 Romos (a pont lerombolva)
66 Megrongalt (a ké sériilt)
998 Nem jellemzo
8. | PFG Relativ magassag szam Relativ magassag Integer
9. | USE A pont rendiiség 26 I. renddi Integer

30 I1. rend(i
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DTA10 V3

Objektum-attributum katalogus €s adatfeltsltési utasitds

Oszlop Leirds Erték Jelentés Adattipus

31 I1. rendii
111 IV. rendii
112 V. rendil
0 Ismeretlen

A | T0PID Topogrdfiai azonosité | ..... Egyedi azonosito L/1/P

B | KART Jelkulcsi azonosité | ... Kartogrdfiai kéd L/1/N

C | TEXT Megirdas |... Magyardzo megirds, rovidités T/*/N

Ditab_V3_tablaza120090214 doc

5. oldal




DTA10 V3

Objektum-attribiitum kataldgus és adatfeltdltési utasitas

2 B-HATAROK és KOZIGAZGATASI EGYSEGEK

2.1 BA_vonal — Hatarok

Feature Class: BA_vonal
Geometriai tipus: VONAL
Oszlop Leirés Erték Jelentés Adattipus
1. |ID A tébléazat sordnak azonositéja | 1, 2, 3,... Autonumber
2. |F_CODE |Objektumkéd FA000 |Kozigazgatasi hatar Text (5)
FA005 |[Egyéb hatar
3. |USE Hasznalat 23 Allam Integer
30 Megye
16 Véros
114 Kozség
112 Kertilet
113 Régio
31 Kistérség
70 Védett terillet
45 Novényzet hatar
999 Egyéb hatar
A | TOPID Topogrdfiai azonosité | ..... Egyedi azonosito L/1/P
B | KART Jelkulcsi azonosito Kartogrdfiai kod L/1/N
C |TEXT Megirds Magyardzo megiras, rovidités T/*/N
2.2 BB_felulet — Kézigazgatasi_egységek
Feature Class: BB_felulet
Geometriai tipus: FELULET
Oszlop Leiras Erték Jelentés Adattipus
1. |ID A tablazat sordnak azonositéja | 1,2, 3,... Autonumber
2. |F_CODE |Objektumkéd FA001 | Kozigazgatdsi egységek Text (5)
3. |USE Kategoria 7 Viéros Integer
9 Kozség
10 Keriilet
2 Védett teriilet
113 Régié
30 Megye
31 Kistérség
999 Egyéb
4. |NAM Név Sz6veg | Terilleti egység megnevezése, Text (80)
"UNK” | Ismeretlen
5. |ksup | Ko b';;’g b(;’;)OMI kozig hatdr\ o svee | Aktudtis érék, Text (10)
A | TOPID Topogrdfiai azonosité | ..... Egyedi azonosité L/1/P
B | KART Jelkulesi azonosité | ... Kartogrdfiai kod L/1/N
C | TEXT Megiras  |.... Magyardzo megirds, rovidités T/*N
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Objektum-attribiitum katalogus és adatfeltoltési utasitas

3 C — EPULETEK és EPITMENYEK

3.1 CA_felulet — Kozépiiletek

Feature Class: CA_felulet
Geometriai tipus: FELULET
Oszlop Leirés Erték Jelentés Adattipus
1. |ID A téblazat sordnak azonositdja | 1, 2, 3,.... Autonumber
. |F_CODE |Objektumkaéd AL015 | Epiiletek (Kozépiilet) Text (5)
3. |BFC Az épiilet funkcidja 3 Orszaghaz Integer
911 Minisztérium
912 Minisztériumi hattérintézmény
909 Megyei Onkorméanyzat -
910 Telepiilési Onkormanyzat
28 Hivatal, egyéb kozépiilet
9 Mizeum - a
. 127 | Szinhdz
118 |Kultirhaz '
6 Korhaz -
7 Radio
11 TV
100  |Klinika I
106 Szanatérium o
60 Egyetem, féiskola
I 905 | Gimnazium . B
906  |Kozépiskola -
- 898 | Technikum - )
15 Alt. Iskola
B 907 Ovoda, bilcsode
151  |Kollégiuom N
953 Vegyes funkcié
4 Vér, varkastély
N h 916 'ay_éx_'mekotthon"_ - _
13 |Borton
109 Szocidlis otthon
950 Uszoda, strand
951 Fiird6é
55 Gyggyﬁlrdo S——
922 Fedett Sportcsarnok
923 Stadion, sportpélya
59 Kutat6 intézet -
35 Postahivatal
128 Koényvtar
10 Csillagvizsgalé
37 Tizoltésag
o I - 12 Rendérség - -
18 Ravatalozé
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Oszlop Leiras Erték Jelentés Adattipus
4. |PFG gdf‘i‘l‘zirg élzss?égelffljjf"e £l 32767,0 |1smeretien, Double
: - 0,0 500,0 | Aktualis érték
5. | Szintsz Szintszam 1 Foldszintes és 1 emelet Integer
2 2-4
- 3 5-7
: : 4 8 és tobb emelet
6. |[NAM Név “UNK” |Ismeretlen, Text (80)
Szoveg | Epiilet, létesitmény neve
A | TOPID Topogrdfiai azonosito Egyedi azonosito L/1/P
B | KART Jelkulcsi azonosité | ... Kartogrdfiai kod L/1/N
C |TEXT Megiras ~  |... Magyardzo megirds, rovidités T/*/N
3.2 CB_felulet — Ipari, iizemi, kereskedelmi épiiletek, épitmények
Feature Class: CB_felulet
Geometriai tipus: FELULET
Oszlop Leiras Erték Jelentés Adattipus
1. |ID A téblazat sordnak azonositdja | 1, 2, 3,.... Autonumber
2. |[F_CODE |Objektumkadd AL015 | Epiiletek (Ipari, kereskedelmi, iizemi) Text (5)
| | Amo20 |sil6 -
3. | BFC Az épiilet funkcidja 116 Ipari, tizemi épiilet
I ) - 501 | Gaz és olajatemeld allomas épﬁlgtr
- 502 Transzformator - i -
§ N 83 Erémd épilet o I
B o 98  [Nyitott szin, fészer . .
- 139 "‘Hl’it“('ﬁt(_)rony
B - 40 | Tavkozlési épillet o
- 24 |Raktar
e . 503 Szénhidrogén tarol6 tanéiyak ]
- 133 |Bolt o )
B - N 122 Bevésériékézpont . ]
] - 925 Szupermarket
o 51 Piac - N i -
4. |PRO Termék 38 Foldgéaz Integer
o 67 Kéolaj ) ]
39 Benzin
- 999  [Egyéb o
5 PFG Magassag a fold felszine felett| -32767,0 [Ismeretlen, Double
) 0,1 méter élességgel [m].
- 0,0 500,0 | Aktualis érték ]
6. | Szintsz Szintszam 1 Féldszintes és 1 emelet Integer
I 2 2-4 -
3 5-7
i - B 4 8 és tobb emelet o ]
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Oszlop Leirés Erték Jelentés Adattipus
7. [NAM Neév “UNK” |Ismeretlen, Text (80)
Szoveg | Epiilet, létesitmény neve
A | TOPID Topogrdfiai azonosité | ..... Egyedi azonosité L/1/P
B | KART Jelkulcsi azonosité ~ |.... Kartogrdfiai kéd L/I/N
c | texr Megirds  |.. Magyarazo megirds, rovidités: TN
Viztorony
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3.3 CB_pont — Epiiletek, épitmények

Feature Class: CB_pont
Geometriai tipus: PONT
Oszlop Leiras Erték Jelentés Adattipus
. |ID A tablazat sordnak azonositdja | 1, 2, 3,.... Autonumber
2. |F_CODE |Objektumkéd AL241 | Toronyszerii kiemelkedd épitmény Text (5)
AL243 | Epiiletek (egyéb, alaprajzban nem 4.)
AL245 | Toronyszerii egyszerii épitmény '
AMO020 | Silé (nem alaprajzban)
AF010 | Kémény
AMO010 | Pince
AMO70 | Tartaly
BB012 | Horgonyz6hely, kikoté
Vallasi épiilet (alaprajzban nem
2B aibrézolhl;té) (vlaprad
AL090 | Tomegsir, egyediilallé sir, kripta
AL116 | Kereszt, képoszlop, haranglib R
AL130 Emlékmii, szobor, kéoszlop
AC010 |Eget6kemence .
AJO51 Szélmotor
AJOS0 | Szélmalom
AJ052 | Vizimalom
ACO001 | Vizi fiirésztelep
AL015 | Epiiletek (Ipari, kereskedelmi, lizemi)
3. |BFC Az épiilet funkciéja 302 Szénhidrogén tarol6 tartalyok Integer
300 Gaz és olajatemeld allomas épiilete -
301 Transzformétor
302 Templomtorony o
- 303 Templom-nem h.szﬁg_elt
1 - 304 Mecset -
400 Kapolna 1
- 401 Minarett S
- 500 Képoszlop" - i
501 Haranglab -
_ 502 Kereszt
| 999 |Egyeb - o |
- R 966 Nyitott varakozdéhely R
- 942 | Benzinkut
| 943 [Foldalatti allomas (jk)
944  |Metréallomas (k) [ O
R 940 | Hajoéallomas I
B i R 941 Horgonyzohely, kikotd
- 945 |Dogkat | |
946 Vadetetd
_ 947 Vadaszles B i
948 "V'i'l'lanytelep o
949 Meteorolégiai 4llomas o
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Oszlop Leirés Erték Jelentés Adattipus
14 Erdészhaz
116 Gyar, iizem épiilete
. 20 Meleghéz
- 950 | Terménytarolé
98 Nyitott szin, fészer jelkulccsal
4, |TTC Torony kategéria (AL241) 10 Kilat6 Integer
- 66 Hidroglébusz
8 Hiit6torony
- 1 Tv, radi6
17 GSM torony
- 882 Templomtorony (nem
hiromszdgelt),kupola
a 6 Viztorony
5. |[PRO Anyag 38 Foldgéz Integer
67 Kdolaj
6. | PFG Magassdg a fold felszine felett | 3767 o | smeretlen, Double
0,1 méter élességgel [m].
- 0,0 500,0 | Aktualis érték
7. | Szintsz Szintszam 1 Foldszintes és 1 emelet Integer
' - 2 2-4
B 3 5-7
B _ 4 8 és tobb emelet
8. INAM Név “UNK” |Ismeretlen, Text (80)
Szoveg |Epiilet, létesitmény neve
A | TOPID Topogrdfiai azonosité | ..... Egyedi azonosité L/1/P
B | KART Jelkulcsi azonosite | ... Kartogrdfiai kéd L/I/N
C | TEXT Megiras ~  |... Magyardzo megirds, rovidités T/*/N
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3.4 CC_felulet — Mezégazdasagi épiiletek, épitmények

Feature Class: CC_felulet
Geometriai tipus: FELULET
Oszlop Leiras Erték Jelentés Adattipus

1. |ID A tablazat sordnak azonositdja | 1,2,3,....... Autonumber

2. |F_CODE |Objektumkdd AL015 | Epiiletek (Mezbgazdasigi) Text(5)

3. |BFC Az épiilet funkcidja 19 Istallé Integer

- 928 | Szarit6 -
1 24 Terménytérol6 B
B ) - 14 |Erdészhaz o
o 20 Meleghéz

- N R 950 Terménytarolée — S

a. | PFG g'lfgr:::f ;ei’slggge:z[‘;;_fe‘e“ -32767,0 |Ismeretlen, Double
v 1 0,0 500,0 | Aktualis érték . R

5. | Szintsz Szintszam 1 Foldszintes és 1 emelet Integer
] . 2 e ) ]
T R 3 5-7 ] I

. 4 8 és tobb emelet R N

6. |[NAM Név “UNK” | Ismeretlen, Text (80)
] - - Szbveg Epiﬁet, 1étesitmény neve - R I

A | TOPID Topogrdfiai azonosité | ..... Egyedi azonosito L/1/P

B | KART Jelkulcsi azonosite | ... Kartogrdfiai kéd L/I/N

C |TEXT Megiras ... Magyardzo megirds, rovidités T/*N

Ditab_V3_tablazat20090214 doc

12. oldal



DTA10 V3

Objektum-attribitum kataldgus és adatfeltdltési utasitds

3.5 CD_felulet — Kozlekedési épiiletek, épitmények

Feature Class: CD_felulet
Geometriai tipus: FELULET
Oszlop Leirés Erték Jelentés Adattipus
1. |ID A téblazat sordnak azonositéja | 1, 2, 3,.... Autonumber
. |F_CODE |Objektumkod AL015 | Epiiletek (Kozlekedési) Text (5)
3. |BFC Az éplilet funkcidja 129 Replil6téri termindl
' 30 Hangér
54 Benzinkit épiilete
o o 94 Vasitallomas
966 Nyitott varakozoéhely
) 965 | Vasiti rakod6
o o 964 Mozdonyszin
962 Vasiti megéllo
D e 963 | Vasiti brhaz
: 130 |Buszallomés
81 Hajo6allomas
a 960  |Metréallomas
961 Foldalatti dllomas
4. |PFG Magassig a fold felszine £. 0,1 | 5,4, Ismeretlen, Double
meéter élességgel [m].
B 0,0 500,0 Aktudlis érték
5. | Szintsz Szintszdm 1 Foldszintes és 1 emelet Integer
2 2-4
3 5-7
4 8 &s tobb emelet
6. |[NAM Név “UNK” Ismeretlen, Text (80)
N Szoveg Epiilet, létesitmény neve
A |TOPID Topogrdfiai azonosité Egyedi azonosité L/1/P
B | KART Jelkulcsi azonosito | ... Kartogrdfiai kéd L/I/N
C |TEXT Megiras ~  |.. Magyaradzo megirds, rovidités T/*/N
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3.6 CE_felulet — Vallasi épiiletek, épitmények

Feature Class: CE_felulet
Geometriai tipus: FELULET
Oszlop Leiras Erték Jelentés Adattipus
. |ID A tablazat sordnak azonosit6ja | 1,2,3,....... Autonumber
2. |F_CODE | Objektumkéd AL016 | Epiiletek (Vallssi)
3. |HWT Az épiilet funkcidja 4 Templom Integer
' - 7 Kolostor — ]
I | 100 [Kapolna - I ]
1 h 101 |Mecset . i
4. | PFG Magasség’a TR -32767,0 |Ismeretlen, Double
0,1 méter élességgel [m].
' o 0,0500,0 |Aktualisérék I
5. | Szintsz Szintszam 1 Foldszintes és 1 emelet Integer
I - 2 |24 o - B ]
| I T X o -
] a i 4 8 és tobb emelet I
6. |NAM Neév “UNK” [ Ismeretlen, Text (80)
i Széveg | Epillet, létesﬁmény neve ]
A | TOPID Topogrdfiai azonosito | ..... Egyedi azonosito L/1/P
B | KART Jelkulesi azonosité - | ... Kartogrdfiai kod i L/I/N
C | TEXT Megiras ~  |... Magyardzo megirds, rovidités: Epiilé T/*N
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3.7 CF_felulet — Egyéb épiiletek, épitmények

Feature Class: CF_felulet
Geometriai tipus: FELULET
Oszlop Leirés Erték Jelentés Adattipus
1. |ID A téblézat sordnak azonositéja | 1,2,3,....... Autonumber
2. |F_CODE |Objektumkod AL015 | Epiiletek (Egyéb) Text (5)
3. |BFC 200 Torténelmi rom
. . 300 Félig lerombolt épilet, rom
- 68 Gétbrhaz
90 Szivattyihaz
115 Turistahaz
95 Hotel, Szalloda
201 Udiilé
11 Kastély
- 16 Lakoépilet
201 Szélmalom
948 R4di6 és TV allomas
949 Meteorologiai allomas
- 0 Ismeretlen
4. |PFG P é"}ef;'édg;:]ls;‘:; felett | 32767,0 | Ismeretlen, Double
. - 0,0 500,0 |Aktualis érték
5. | Szintsz Szintszdm 1 Foldszintes és 1 emelet Integer
2 2-4
- 3 5-7
R 4 8 és tobb emelet
6. |NAM Név “UNK” | Ismeretlen, Text (80)
o Szoveg | Epiilet, létesitmény neve
A | TOPID Topogrdfiai azonosité | ..... Egyedi azonosité L/1/P
B | KART Jelkulcsi azonosito Kartogrdfiai kéd L/I/N
C |TeExT Megirds ~ |... Magyardzo megirds, rovidités T/*/N
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3.8 CG_vonal — Keritések, falak

Feature Class: CG_vonal
Geometriai tipus: VONAL
Oszlop Leirés Erték Jelentés Adattipus
. |ID A téblazat sordnak azonositéja | 1, 2, 3,... Autonumber
2. |F_CODE |Objektumkdéd AL260 |Fal Text (5)
' ALO70 |Kerités

3. |FWT Fal/Kerités tipusa 6 Késor Integer

7 Téamfal-AL260

o 8 Varfal-AL260
9 Torténelmi falak-AL260
10 Zajvédofal-AL070
o - B 2 Vas, drétkerités és betonlabazat-AL070
4. (MCC Anyag 0 Ismeretlen
- 9 Tégla
o 21 Vasbeton
. 40 Uveg
o 64 Fém
- 74 Miianyag
' 108 [Ko
117 Fa
- o 120 | Drot
o = 121 Szbgesdrot
......... - ' 555 Eah
5. [NAM Név “UNK” | Ismeretlen, Text (80)
- Szoveg | Epiilet, létesitmény neve

A | TOPID Topogrdfiai azonosité | ..... Egyedi azonosito L/1/P
B | KART Jelkulcsi azonosite | ... Kartogrdfiai kéd L/I/N
C |TEXT Megiras ~ |... Magyardzo megiras, rovidités T/*/N
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4 D — KOZLEKEDES

4.1 DA_felulet — Kozlekedési létesitmények

Feature Class: DA _felulet
Geometriai tipus: FELULET
Oszlop Leiras Erték Jelentés Adattipus
1. |ID A tablazat soranak azonositéja | 1,2,3,....... Autonumber
2. |F_CODE |Objektumnkod AP030 | Kozt Text (5)
AQ135 | Autéspihend
- | GB055 |Repiilétéri kifutépalya
GBO015 | Repiil6téri 4ll6hely
3. |TUC gflf(l)‘;‘g‘)dés' haszndlat tipusa| 151 | Autepalya Integer
152 Autoéit, korszerti miit
153 Miiit
- 154 Javitott talajut
- 155 | Talajut
N - 158 | Kerékparut
4, |MCC Burkolat anyaga (AP030) 0 Ismeretlen Integer
- 5 Aszfalt
a 8 K6, murva
21 Beton
- 46 Kavics
N - 57 Makad4m
- 101 |Salak
i 45 Gyep
. 998 Nem jellemz6
""" 999 | Egyéb
5. |WD2 '(F:gg; (J)?rhato tszélesség [m]. -32767 | Ismeretlen, Integer
B -32765 | Nem jellemzs,
1 — 32763 | Aktudlis érték
6. |EXS Miikddés (AP030) 5 Epités alatt Integer
27 Lezart
- 28 Mitksdd
7. |RTN Utszam (Nemzeti) (AP030) »UNK” | Ismeretlen, Text (24)
- Szbveg | Aktudlis Gtszam
»N_A” | Nem jellemz6
8. |RTE Utszdm (Nemzetkizi) (AP030)| , UNK” |Ismeretlen, Text (24)
=, Szoveg | Aktudlis vitszdm
I WN_A" | Nem jellemzd
9. |INAM Név “UNK” |Ismeretlen, Text (80)
==— Sztveg |Epiilet, létesitmény neve
10. [LTN Savok szdma (AP030) -32767 | Ismeretlen, Integer
1< Aktualis érték,
- - -32765 |Nem jellemzd
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Oszlop Leiras Erték Jelentés Adattipus
A | TOPID Topogrdfiai azonosité | ..... Egyedi azonosito L/1/P
B | KART Jelkulcsi azonosite | ... Kartogrdfiai kod L/I/N
C | TEXT Megiras Magyardzo megirds, rovidités T/*N
4.2 DA_vonal — Kézlekedési létesitmények
Feature Class: DA_vonal
Geometriai tipus: VONAL
Oszlop Leiras Erték Jelentés Adattipus
. |ID A téblazat soranak azonositéja | 1,2,3,....... Autonumber
2. |F_CODE |Objektumkad AP030 | Kdzut Text (5)
G AP033 | Nyitott 4tjaré
| Apro3s thtengely
o - AQ130 |Alagut
3. |TUC zflfg;l;e)dés‘ hasznélat tipusa 155 | Talajit Integer
156 Mezei és erdei 1t
S . 5 R p——
. 158 | Kerékparit
4. |MCC Burkolat anyaga (AP030) 0 Ismeretlen Integer
5 Aszfat
o 8 K6, murva
21 Beton
46 Kavics
o 57 Makadém
101 Salak
i 45 Gyep
998 Nem jellemz6
999 Egyéb
5. |LEN Hossz/ atmérd [m] -32767 | Ismeretlen, Integer
S 0< [Aktudlis érték
VC3 Biztonségos magassdg a f6ld| -32767,0 |Ismeretlen
6. felszine felett 0,1 méter Double
élességgel [m].
- 0,0 > 4,3 | Aktualis érték
-32767,0 |Nem jellemzd
7 WGP Szélesség 0,1 méter élességgel | -32767,0 |Ismeretlen Double
[m].
0,0 20,0 [ Aktudlis érték
8. [NAM Név “UNK” [ Ismeretlen, Text (80)
- Szoveg |Epillet, létesitmény neve
A | TOPID Topogrdfiai azonosité | ..... Egyedi azonosito L/1/P
B | K4RT Jelkulcsi azonosito | ... Kartogrdfiai kéd L/1/N
C | TEXT Megiras ~  |.. Magyardzo megirds T/*/N
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4.3 DA_pont — Kozlekedés létesitmények

Feature Class: DA_pont
Geometriai tipus: PONT
Oszlop Leiras Erték Jelentés Adattipus

1. 1ID A téblazat soranak azonositéja | 1,2,3,....... Autonumber

2. |F_CODE |Objektumkéd AQ100 | Koziti km-kd és km-tdbla Text (5)
AQ105 | Utmenti jelz6tabla

R _ AQ106 | Utmenti segélykeérs telefon
o AQ130 |Alagit bejérata
o AQI125 | Aut6busz megall6hely
3. |TLI Kilométer érték [km] 32765 |nom. Jellemsd - (elkertld kM-l nteger
Oveihez)
1< Aktudlis érték

4. [NAM Név “UNK” [Ismeretlen, Text (80)
Szoveg | Epillet, létesitmény neve

A | ToPID Topogrdfiai azonosité | ... Egyedi azonosité L/1/P

B | KART Jelkulesi azonosité | ... Kartogrdfiai kod L/I/N

C | TEXT Megiras ~  |... Magyaradzo megirds, rovidités T/*/N
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4.4 DB_vonal — Vasut, drétkotéipalya

Feature Class: DB_vonal
Geometriai tipus: VONAL
Oszlop Leiras Erték Jelentés Adattipus
1. |ID A téablazat soranak azonositdja | 1,2,3,....... Autonumber
2. |F_CODE |Objektumkéd ANO010 | Vasiit Text (5)
- ATO041 | Drétkotélpalya
3. |RRC Vasut kategéria 995 Fiiggbvast, siklé Integer
- ' - 14 Villamosvonal
o 15 Fogaskerekiivonal
o 7 Foldalattivonal -
- o 6 Metrévonal
- 17 Iparvagany
R 970 | Vaganyhal6zat (allomas)
- o 980  [Sifelvon6 -
- 982  |Libegé
984 | Trolibuszvonal
' 996  |HEV
999 Egyéb
13 Erdei
4. [RRA Vasiiti energiaforras 1 Elektromos sinpér Integer
3 Elektromos felsé vezeték
4 Nem elektromos
5. |RGC Nyomtav 1 Széles Integer
_ - 2 Keskeny
3 Normal
6. |RTA Vagéanyok szdma 0 Ismeretlen Integer
" - 1 Egyvéagényt
' i 2 |Kétvaganyn
- 3 Tobbvaganyt
7. |NAM Név »UNK” | Ismeretlen, Text (80)
Szdéveg | Vasitvonal neve
8. |LOC Elhelyezkedés 4 Foldfelszin alatti Integer
o ' ' ' ' 8 Foldfelszini
o N 0 Ismeretlen
A | TOPID Topogrdfiai azonosité | ..... Egyedi azonosito L/1/P
B | KART Jelkulcsi azonosito | ... Kartogrdfiai kod L/I/N
C | TEXT Megiras  |.. Magyardzo megirds, rovidités T/*/N
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4.5 DB_pont — Vasut

Feature Class: DB_pont
Geometriai tipus: PONT
Oszlop Leiras Erték Jelentés Adattipus
. {ID A tablazat soranak azonositdja | 1,2,3,....... Autonumber
2. |F_CODE | Objektumkadd ANO076 | Fényjelz6, szemafor
ANO078 | Vasiti km-k6, km tdbla
ANO075 | Fordit6korong
3. |TLI Kilométer érték [km] -32765 [Nem jellemz6 Integer
) 1< |Aktualis érték
A |TO0PID Topogrdfiai azonosité | ..... Egyedi azonosito L/1/P
B | KART Jelkulesi azonosite -~ | ... Kartogrdfiai kéd L/I/N
C | TEXT Megiras ~ |... Magyardzo megirds, révidités T/*N
4.6 DC_felulet — Hidak,atkel6k
Feature Class: DC_felulet
Geometriai tipus: FELULET
Oszlop Leiréds Erték Jelentés Adattipus
1. |ID A tablazat soranak azonositéja | 1,2,3,....... Autonumber
2. [F_CODE |Objektumkod AQ040 |Hid Text (5)
- AQ045 | Vasuti gyalogos feliiljaro
AQ046 | Pontonhid
3. |MLC Teherbirds [t] -32767 | Ismeretlen, Integer
- | 1® 32763 | Aktualis értek
4. IMCC Objektum anyaga 0 Ismeretlen Integer
- 21 Vasbeton
' 64 Fém
- 108 |Ké
o - 117 |Fa
5. [LEN Hosszisag [m] -32767 | Ismeretlen, Integer
3< Aktudlis érték
6. |wD1 Minimélis jarhat6 szélesség| 35767 | [gneretlen, Integer
[dm].
0< Aktudlis érték
7. [NAM Név “UNK” | Ismeretlen, Text (80)
- - Széveg | Hid neve
A |TOPID Topogrdfiai azonosité Egyedi azonosito L/1/P
B | KART Jelkulcsi azonosité Kartogrdfiai kéd L/1/N
C | TEXT Megiras ~ |... Magyardzo megirds, rovidités T/*/N
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4.7 DC_vonal — Hidak, atkel6k

Feature Class: DC_vonal
Geometriai tipus: VONAL
Oszlop Leiras Erték Jelentés Adattipus
1. |ID A tablazat soranak azonositéja | 1,2,3,....... Autonumber
2. |F_CODE | Objektumkoéd AQ041 | Biirii Text (5)
- AQ042 | Gyalogos felilljaré
- AQ065 | Ateresz
- | AQ040 | Jelzéhid
- | AQ070 [ Kompatkelés
BHO070 | G4azlé
3. | PFE f;;ls?:gzgel ‘}:ﬁ}#s“‘g 0.1 méter|  37767,0 | ismeretlen, Double
3;’706?’0 Aktualis érték
4. |MLC Teherbirds [t] -32767 | Ismeretlen, Integer
1 ® 32763 | Aktudlis érték
5. |LEN Hosszusag [m] -32767 | Ismeretlen, Integer
3< Aktudlis érték
6. | FER Meghajtas tipusa 0 Ismeretlen Integer
- - 1 Drotkotél (lanc)
- 2 Onjaré (k6tél nélkiili)
- 996 Motoros
) 997 Motoros csénak
998 Csonak
7. | PRO ?f:ﬂ;kkt;ﬁés ég) anyaga 0 Ismeretlen Integer
_ 16 Agyag
o 46 Kavics
B 88 Homok
999 Egyéb
8. |INAM Név “UNK” | Ismeretlen, Text (80)
- Szoveg | Hid neve
A | TOPID Topogrdfiai azonosité | ..... Egyedi azonosité L/1/p
B | KART Jelkulcsi azonosito ™ | ... Kartogrdfiai kod L/I/N
C |TEXT Megirds Magyardzo megiras, rovidités T/*N
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4.8 DC_pont — Hidak, atkel6k

Feature Class: DC_pont
Geometriai tipus: PONT
Oszlop Leiras Erték Jelentés Adattipus
. |ID A tablazat sordnak azonositéja | 1,2,3,....... Autonumber
2. |F_CODE |Objektumkéd AQ065 | Ateresz Text (5)
3. |MLC Teherbirds [t] -32767 |Ismeretlen, Integer
"""" o 1® 32763 | Aktudlis érték
4. |[MCC Objektum anyaga 0 Ismeretlen Integer
- 21 Vasbeton
64 Fém
o 108 |Ké
o 117 |Fa
5. |LEN Hosszuséag [m] -32767 |Ismeretlen, Integer
3< Aktudlis érték
6. | WDI1 Minimalis jarhat6 szélesség -32767 | Ismeretlen, Integer
[dm].
0< Aktudlis érték
A | TOPID Topogrdfiai azonosité | ..... Egyedi azonosité L/1/P
B | KART Jelkulesi azonosite | ... Kartogrdfiai kod L/I/N
C | TEXT Megirds Magyarazo megirds, rovidités T/*/N
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5 E — KOZTERULETEK és EGYEB TERULETEK

5.1 EA_felulet — Belteriileti kdzteriiletek

Feature Class: EA_felulet
Geometriai tipus: FELULET
Oszlop Leiras Erték Jelentés Adattipus
1. |ID A tablazat sordnak azonositéja | 1,2,3,....... Autonumber
2. |[F_CODE [Objektumkéod AL020 | Belteriileti kdzteriiletek Text (5)
AL030 | Temetd
3. |USE Hasznélat jellege 950 Udvar Integer
999 Egyéb
800 Koztér
- - 130 |Utca
. _ | 802 |Diszkert
803 Park
- | 951 |Villaszeri beépitettség, teriilet
804 Parkold
805 Temetd fakkal
808 Temetd fak nélkiil
806 Gyalogosan jarhato utca
_ - 807 Diszkertek, parkok, gylimodlcsosok. utja
4. |[NAM Név »UNK” [ Ismeretlen, Text (80)
' - Szoveg | Beépitett teriilet, telepiilés neve
A | TOPID Topogrdfiai azonosité | ..... Egyedi azonosito L/1/p
B | KART Jelkulcsi azonosité | ... Kartogrdfiai kéd L/I/N
C |TExXT Megiras Magyardzo megirds, rovidités T/*N
5.2 EA_pont — Belteriileti kozteriiletek
Feature Class: EA_pont
Geometriai tipus: PONT
Oszlop Leiras Erték Jelentés Adattipus
1. |ID A tablazat sordnak azonositdja | 1,2,3,....... Autonumber
. |F_CODE [ Objektumkéd AL030 | Temetd Text (5)
3. INAM Név »UNK” | Ismeretlen, Text (80)
- - Szbveg |Temetd neve
4. |USE Hasznalat jellege 805 Temetd fakkal
i - 808 | Temetd fak nélkiil
A | TOPID Topogrdfiai azonosito Egyedi azonosito L/1/P
B | KART Jelkulcsi azonosite | ... Kartogrdfiai kod L/I/N
C | TEXT Megirds ... Magyardzoé megirds, rovidités /%N
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5.3 EB_felulet — Egyéb teriilet

Feature Class: EB_felulet
Geometriai tipus: FELULET
Oszlop Leirés Erték Jelentés Adattipus
1. |ID A tablazat sordnak azonositéja | 1,2,3,....... Autonumber
2. |F_CODE |Objektumkoéd EA032 | Arborétum Text (5)
s e =g = AKO040 | Stadion, sportpalya
AL105 |Tanya teriilete
N AK122 | Egyéb teriilet
3. |[MCC Burkolat anyaga 5 Aszfalt Integer
5 Seron
T 101 |Salak
- 45 Gyep
4. |USE Hasznélat jellege 313 Golfpélya Integer
314 Bobpilya
- 315  |Sipélya
- 316 Cross pélya
317 Létér
318 Auté-motor versenypélya
999 Egyéb
5. |NAM Név “UNK” | Ismeretien, Text (80)
B Szoveg | Epiilet, létesitmény neve
A |TOPID Topogrdfiai azonosité Egyedi azonosité L/1/P
B | K4ART Jelkulcsi azonosité Kartogrdfiai kéd L/1/N
C |TEXT Megiras |... Magyardzé megirds, rovidités T/*N
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6 F — IPARI, MEZOGAZDASAGI, KOZLEKEDESI, KERESKEDELMI
UZEMEK és LETESITMENYEK

6.1 FA_felulet — Ipari, mez6gazdasagi, k6zlekedési lizemi teriiletek

Feature Class: FA_felulet
Geometriai tipus: FELULET
Oszlop Leiras Erték Jelentés Adattipus
1. |ID A tablazat soranak azonositdja | 1,2,3,....... Autonumber
2. |F_CODE |Objektumkéd AC000 | Ipari, Mezégazdasdgi lizem Text (5)
) AQ125 |Allomss .
AC005 | Kereskedelmi céli teriilet
- AC010 |Erdmi teriilete
3. |PPC Er6mii tipus 1 Vizi Integer
2 Nuklearis
- 3 Nap o
- 4 | Termalhé
. 5 3 I
a 7 Belsd égésii
4. |USE Hasznélat 301 Géz és olajatemeld allomas Integer
N 302 Allattenyésztés -
h 303 Novénytermesztés
B 304 | Vasutallomas -
305 Buszéllomas
306 Hajéaliomas
307 Metréallomas
308 Foldalatti dlomas o S o
o 309 | Kikoto -
- ) 310 | Villanytelep -
41 Ipari iizem, gyar
) o 314 Szennyviztisztito telep
) 315 Szennyviz derit6
| | 311 |Hulladékleraké hely
- 312 Szeméttelep | ]
5. |PRO Anyag (AC000, AQ116) 0 Ismeretlen Integer
2 Aluminium N ]
- a 5 Aszfalt a 1
- 9 Tégla
B 11 [Cement
13 _\Egyszer _
- 21 Beton
- 31 Elektronikai N
R 35  |Elelmiszer ]
| ' i 38 Foldgaz (AQ116) N
I T  Benzin
- | a0 |Oveg h o
- B 56 Fa (fiirészéru)
_ 64 |Fém L
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Oszlop Leiras Erték Jelentés Adattipus
67 Kdolaj (AC000 és AQ116)
68 Szén
71 Papir
74 Miianyag
o . 95 Szennyviz (AQ116)
== 107 [Acél
109 Cukor
116 Viz (AQ116)
' 129  |Dohény
. 135 Szévet/Textil
137 Gépjarmii
998 Nem jellemzé
999 Egyéb
6. |NAM Neév “UNK” [Ismeretlen, Text (80)
R - Széveg | Teriilet neve
A | TOPID Topogrdfiai azonosito Egyedi azonosité L/1/P
B | KART Jelkulesi azonosité | ... Kartogrdfiai kod L/I/N
C | TEXT Megiras ... Magyardzo megiras, rovidités T/*/N
6.2 FB_vonal — Elektromos és tavkozlési vezetékek
Feature Class: FB_vonal
Geometriai tipus: VONAL
Oszlop Leirés Erték Jelentés Adattipus
1. [ID A tablazat sordnak azonositdja | 1, 2, 3,.... Autonumber
2. |F_CODE [Objektumkdd ATO030 | Villanyvezeték Text (5)
- AT060 |Telefon vezetékek
AT005 Fold, viz alatti vezetékek
3. |[KVA ’(I‘:;gz()e)ték fesziltsége [kV] -32767 | Ismeretlen, Integer
R 20 — 2000 [ Maximalis fesziiltség kV-ban kifejezve
-32765 | Nem jellemzd
4. |[MCC Anyag 64 Fémtart6 Integer
996 Beton és fa
A | TopriD Topogrdfiai azonosité Egyedi azonosité L/1/P
B | K4RT Jelkulcsi azonosité Kartogrdfiai kod L/I/N
c | rexr Megirds Magy.ara:zé megirds, rovidités: Pincék, /%N
Borpincék, Bg.

Ditab_V3_tablazat20090214 doc

27. oldal




DTA10 V3

Objektum-attributum kataldégus és adatfeltoltési utasitds

6.3 FB_pont — Elektromos vezetékek tartozékai

Feature Class: FB_pont
Geometriai tipus: PONT
Oszlop Leiras Erték Jelentés Adattipus
. |ID A tablazat soranak azonositdja | 1,2,3,....... Autonumber
2. |F_CODE [Objektumkéd ATO040 Ridcsos tartészerkezet Text(5)
3. | PFG g’li“i‘::rg ;ef?s':gfgeelfz[‘;;fe'e“ -32767,0 | Ismeretlen, Double
' 0,0 500,0 | Aktualis érték
A | TOPID Topogrdfiai azonosito FEgyedi azonosito L/1/P
B | KART Jelkulcsi azonosite | ... Kartogrdfiai kod L/I/N
C |TEXT Megiras | .. Magyardzo megirds, rovidités T/*/N
6.4 FD_vonal — Termékvezetékek
Feature Class: FD_vonal
Geometriai tipus: VONAL
Oszlop Leiras Erték Jelentés Adattipus
. |ID A tablazat soranak azonositéja | 1, 2, 3,.... Autonumber
2. |F_CODE |Objektumkéd AQ113 | Termékvezetékek Text (5)
3. [PRO Termék kategoéria 13 Vegyi (termék) Integer
38 Foldgaz
39 Benzin
""" R B 50 H6
S 67 Kdolaj
95 Szennyviz -
- & 116 |Viz
- 998 | Vegyes felhasznalasi
999 Egyéb
4. |NAM Név »UNK” | Ismeretlen, Text (80)
Szoveg | Vezeték neve
5. |LOC Elhelyezkedés 0 Ismeretlen Integer
4 Felszin alatti
o s Felszini
- 25 Fiiggesztett v. megemelt (szarazfdld v.
viz felett)
6. |PFG Relativ magassag Relativ magassag Integer
A | TOPID Topogrdfiai azonosité | ... Egyedi azonosito L/1/P
B | KART Jelkulcsi azonosite | ... Kartogrdfiai kod L/I/N
C |7ExT Megiras Magyardzo megirds, rovidités T/*N

Ditab_V3_tablazat20090214 doc

28. oldal




DTAI10 V3

Objektum-attribiitum katalogus és adatfeltoltési utasitas

7 G — TERMESZETI EROFORRASOK

7.1 GA_felulet — Banyaszat

Feature Class: GA_felulet
Geometriai tipus: FELULET
Oszlop Leiréas Erték Jelentés Adattipus
1. |ID A téblézat sordnak azonositdja | 1,2,3,....... Autonumber
2. |[F_CODE [Objektumkéd AB000 |Meddéhény6 Text (5)
- AA010 |Banyateriilet
- DB145 | Feltirt terillet
AA011 | Kiilszini fejtés
3. [PRO Anyag 17 K6szén, lignit Integer
""""" 23 Rézérc
51 Vasérc
64 Egyéb érc (szines-, nemesfém)
87 K6s6
- 8  |Ké
112 Urénérc
- 119 |Bauxit
) 38 Foldgaz
- 67 Kéolaj
T 500 — _
201 Tozeg
o o 999  [Egyéb
4. |EXS Miikodés 6 Felhagyott Integer
' 28 Miik6d6
5. |PFG g‘fi‘:::f éalef;‘;zdg;‘:f;‘;‘; felett | 32767,0 | Ismeretlen, Double
- 0,0 500,0 | Aktudlis értek
6. |NAM Név “UNK” | Ismeretlen, Text (80)
- Szoveg Epﬁié"t":létesitlﬁény neve
A | TOPID Topogrdfiai azonosité | ..... Egyedi azonosité L/1/P
B | KART Jelkulcsi azonosite | ... Kartogridfiai kéd L/I/N
C |TEXT Megiras  |... Magyardzé megirds, rovidités T/*/N
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7.2 GA_pont — Banyaszat

Feature Class: GA_pont
Geometriai tipus: PONT
Oszlop Leiras Erték Jelentés Adattipus
1. {ID A tablazat sordnak azonosit6ja | 1,2,3,....... Autonumber
2. |F_CODE |Objektumkod AQ090 | Akna Text (5)
AQ095 |Térna
B i AA050 | Ipari kutak
- . AA051 | Farélyuk
a AF070 | Gazfaklya
) AB000 | Meddéhanyé (jk)
3. |PRO Anyag 17 K&szén, lignit Integer
- 23 Rézérc
: 51 Vasérc
64 Egyéb érc (szines-, nemesfém)
' - 87 K656
: 112" |Urénérc
119 Bauxit
R 38 Foldgaz
67 Kéolaj
i 200 | Termalviz
- - 999 |Egyéb
4. |EXS Miikddés 6 Felhagyott Integer
B 28 Miikods
998 | Kutat6 -
5. | PFE Jellemz6 mélység  méter| 35007 | [smeretlen, Double
élességgel [m].
; ;’706;?0 Aktudlis érték
6. [NAM Név “UNK” [ Ismeretlen, Text (80)
a Szoveg | Epiilet, létesitmény neve
A | TOPID Topogridfiai azonosité Egyedi azonosito L/1/P
B | KART Jelkulcsi azonosito Kartogrdfiai kéd L/I/N
C |7ExT Megirds ~ |... Magyardzo megirds, rovidités T/*/N
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8 H — VIZEK és VIZUGYI LETESITMENYEK

8.1 HA_felulet — Vizhalozat és tarolok

Feature Class: HA_felulet
Geometriai tipus: FELULET
Oszlop Leiras Erték Jelentés Adattipus
1. |ID A téblazat soranak azonositéja | 1,2,3,....... Autonumber
2. |F_CODE Objektumkod BH140 |Természetes vizfolyds Text (5)
- | BH141 [Folyé, folyam
BHO80 | Természetes tavak -
i BHO020 Esatorna, arok
' BH130 | Mesterséges t6, viztirozé
BH090 |Mederteriilet -
o - AMO070 | Viztarold, ciszterna
= BH040 | Deritd, szikkaszt6, zagytirozé
3. |HYC Vizrajzi kategéria 6 Id6szakos/Valtozo Integer
8 Allandé
o 3 Széraz
N 10 |Felszin alatti )
N 1 Epils
4. |NAM Név »UNK” [ Ismeretlen, Text (80)
o Szoveg | T6, viztarozo6 neve
Az  objektum legnagyobb
5. |PFE mélysége 0,1 méter élességgel [ -32767,0 |Ismeretlen, R/1/N
[m]. (BH080, BH130)
- -32765,0 |Nem jellemz8,
: 0,0< |Aktudlis érték
6. |WD3 ?A’;;imélis Athidaldsi s2€1esség | 33767 | 1smeretlen, L/IN
' 0< | Aktudlis értek
A | TOPID Topogrdfiai azonosité Egyedi azonosito L/1/P
B | KART Jelkulcsi azonosité | ... Kartogradfiai kéd L/I/N
C | TEXT Megiras  ]... Magyardzo megirds, rovidités T/*/N
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8.2 HA_vonal — Vizhalézat

Feature Class: HA_vonal
Geometriai tipus: VONAL
Oszlop Leiras Erték Jelentés Adattipus
1. |ID A tablazat sordnak azonositdja | 1,2,3,....... Autonumber
2. |F_CODE |Objektumkdd BH140 | Patak Text (5)
e BRI20 | Zigs
o BHI80 |Vizesés a
- - BH210 |Partvonal

- : BH020 |Csatorna, Arok
3. |HYC Vizrajzi kategdria 3 Széraz Integer

' - 6 Idészakos/Valtoz6

8 Allandé
o 10 Felszin alatti

- 995 | Bivé

4. |PFD Vizesés mélysége (magassdga) | -32767 | Ismeretlen, Integer
[m] 0< | Akuualis értek )
5. | DR3 Mélység [m], 0.1 m élességgel | -32767,0 |Ismeretlen, Double
sk 0% T
6. [NAM Név »UNK” | Ismeretlen, Text (80)
- Szoveg | Vizfolyés neve

A | T0oPID Topogrdfiai azonosité Egyedi azonosito L/1/P
B | KART Jelkulcsi azonosite | ... Kartogrdfiai kéd L/I/N
C | TEXT Megiras |... Magyardzo megirds, rovidités T/*/N
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8.3 HA_pont — Viznyerd helyek és tarolok

Feature Class: HA_pont
Geometriai tipus: PONT
Oszlop Leiras Erték Jelentés Adattipus
1. |ID A téablazat sordnak azonositoja | 1,2,3,....... Autonumber
2. |[F_CODE |Objektumkéd AA050 |Kut Text (5)
- BH170 |Forras
AMO070 | Viztartaly
- AMO75 | Viztartdly, ciszterna
3. |EXS Miikodés 6 Felhagyott
28 Miiksdo
4. |NAM Név »UNK” | Ismeretlen,
Szbveg | Viznyer6hely neve
5. | WET Kut fajtaja 2 Kiépitett forrds Integer
3 Artézi kat
R 5 Asott/Furt kiit
- 6 Gémeskat
- 7 Szélmotoros kit
- 8 Vizmiivek emelt kitja
IEE o 900 | Szokékut
- o 9 Vizvezetéki kozkut
- 999  |Egyéb
6. [SCC Forras/kut vizének jellege 4 Asvanyviz Integer
- 991 Gyégyviz
- 999  |Egyéb
Jellemz6 magassig a fold
7. |PFG felszine felett 0,1 méter| -32767,0 |Ismeretlen, Double
élességgel [m].
- | -32765,0 |Nem jellemzs,
| 0,0500,0 |Aktualis érték
A |TOPID Topogrdfiai azonosité | ..... Egyedi azonosité L/1/P
B | KART Jelkulcsi azonosité | ... Kartogrdfiai kéd L/I/N
C | TEXT Megirds Magyarazo megirds, rovidités T/*/N
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8.4 HB_felulet — Mdtargyak

Feature Class: HB_felulet
Geometriai tfpus: FELULET
Oszlop Leiras Erték Jelentés Adattipus
1. |ID A tabléazat sordnak azonositéja | 1,2,3,....... Autonumber
2. |F_CODE |Objektumkéd BB190 | Molo Text (5)
: - BI020 | Duzzasztégat
3. | TUC Kozlekedés tipusa 1 Ut + vasit Integer
3 Vast
- 4 Ut
o R 32 Kerékpar
o - 35 Nincs rajta kdzlekedés
) 998  [Nem jellemzs
4. |[MCC Anyagosszetétel 21 Vasbeton Integer
- a 30 Fold
o 62 Tégla/K
999 Egyéb
5. | WID Szélesség [m] -32767 | Ismeretlen, Integer
- 0<  |[Aktualis érték
6. |RELZ Relativ magassagkiilonbség "2,5" Integer
7. |[NAM Név “UNK” | Ismeretlen, Text (80)
- o Szoveg | Epillet, létesitmény neve
A | TOPID Topogrdfiai azonosité | ..... Egyedi azonosito L/1/P
B | KART Jelkulcsi azonosité | ... Kartogrdfiai kod L/1/N
C |TEXT Megiras  |... Magyardzo megirds, rovidités T/*/N
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8.5 HB_vonal — Miitargyak

Feature Class: HB_vonal
Geometriai tipus: VONAL
Oszlop Leiras Erték Jelentés Adattipus
1. |ID A tablazat soranak azonositdja | 1,2,3,....... Autonumber
2. |F_CODE |Objektumkdd BI030 | Zsilip Text (5)
BB190 | Mo6lé
o | BI043 [Sarkantyd, vezetémi, hullimt5ré
B1020 Duzzasztégat
3. |USE Hasznélat 100 Zsilip Integer
- : 124 Vizelosztd zsilip
- 101 Kamrazsilip
4. |[MCC Anyaga 21 Vasbeton Integer
) 30 Fold
- 62 Tégla/Ké
999 Egyéb
5. |RELZ Relativ magassagkiilonbség Aktudlis érték Integer
NAM Név “UNK” | Ismeretlen, Text (80)
o Szoveg |Epiilet, létesitmény neve
A | TOPID Topogrdfiai azonosité Egyedi azonosité L/1/P
B | KART Jelkulcsi azonosito Kartogrdfiai kéd L/I/N
C | TEXT Megiras ~ |... Magyardzo megirds, rovidités T/*/N
8.6 HB_pont — Miitargyak
Feature Class: HB_pont
Geometriai tipus: PONT
Oszlop Leiras Erték Jelentés Adattipus
. |ID A tablazat soranak azonositdja | 1,2,3,....... Autonumber
2. |[F_ CODE |Objektumkéd BI030 | Zsilip Text (5)
BCO030 | Jelzéfény — vizi
: B GB010 | Jelzdfény — repilldtéri navigcios
R ) BC099 | Folyami jelzd és km tdbla
| BG020 | Vizmérce
BHO012 | Fedett csatorna torkolata
3. |USE Hasznélat 130 Duzzaszt6 zsilip Integer
B - 124 Vizeloszté zsilip -
4. [TLI1 Kilométer érték [km] -32765 | Nem jellemz6 Integer
- 1< Aktudlis érték
5. |HGT Null pont absz. mag. Aktudlis érték
. |HGU Ko6zépviz absz. mag. Aktudlis érték
7. |NAM Név “UNK” [Ismeretlen, Text (80)
N Szdveg Léte_sitm:ény_riae o -
A |TOPID Topogrdfiai azonosité | ..... Egyedi azonosito L/1/P
B | KART Jelkulcsi azonosité Kartogrdfiai kéd L/1I/N
C | TEXT Megirds |... Magyardzé megirds, rovidités T/*/N
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9 | — NOVENYZET és TALAJNEMEK

9.1 |A_felulet — Erddk és fak

Feature Class: 1A_felulet
Geometriai tfpus: FELULET
Oszlop Leiras Erték Jelentés Adattipus
1. |ID A tablazat sordnak azonositéja | 1,2,3,....... Autonumber
2. |F_CODE |Objektumkéd EC015 |Erdé Text (5)
o EC020 |Sarjerdd, kivagott erdd
"""""""""""""" EB035 |Bozé6t
EC040 | Nyiladék
3. |TRE Fafajta 0 Ismeretlen Integer
1 Lombhullaté
' 2 Orokzold
3 Vegyes
B 5 Tiiskés
4. [VEG Novényzet 0 Ismeretlen Integer
o 17 Erdeifeny6
18 Biikk
) 30 Tolgy
34 Nyir
44 Szil
- o 46 Nyar
B 47 Kéris
94 Feketefenyd
95 Vorosfenyd
96 Juhar
97 Fliz
98 Bordka
- 999 Egyéb szélerdd
. 100 | Ritka szalerds
: 101 | Széttordelt erdd
103 Csemetekert
104 Torpe erdd
a 90 Akac
91 Cser
92 Gyertyén
a o 93 Lucfeny6
. 89 Som
B 90 Vadrozsa
o 91 Galagonya
- 92 Kokény
93 Magyal
36 Gesztenye
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Oszlop Leirés Erték Jelentés Adattipus
Torzsvastagsadg (0,1 méter
5. |SDR élességgel 1,4 m magassagban | -32765,0 |Nem jellemzd Double
meérve) [m].
-32767,0 |Ismeretlen,
- ) 0,0< |Aktualis érték
6. | TSD (F(f‘l; ;‘gtze‘:tgle:iaggg‘;ﬁ) ;‘;’;’]‘fls‘/’g -32765,0 | Nem jellemzb Double
- -32767,0 | Ismeretlen, -
0,0< Aktudlis érték
7. | PFG Jellemz6 magasség (0,1 méter| 3,765 ) | Nem jellemzs Double
élességgel) [m].
- -32767,0 |Ismeretlen
o 0,0< |Aktualis érték
8. [NAM Név »UNK” [Ismeretien, Text (80)
) Széveg | Erd6 neve
A | TOPID Topogrdfiai azonosité Egyedi azonosito L/1/P
B | KART Jelkulcsi azonosité Kartogrdfiai kéd L/1/N
C |7TExT Megiras ~ |... Magyardzé megirds, rovidités T/*/N
9.2 |A_vonal — Erddk és fak
Feature Class: IA_vonal
Geometriai tipus: VONAL
Oszlop Leiras Erték Jelentés Adattipus
1. |ID A téblézat sordnak azonositdja | 1,2,3,....... Autonumber
2. |F_CODE [Objektumkod EC030 |Fasor Text (5)
B EC035 |Erddsav
- EA020 | Bokorsor, Elésvény
3. [DRW Hasznélat 1 Ritka Integer
: 3 Surit
4 Keskeny
- o 5 Fiatal
A |T0PID Topogrdfiai azonosité | ..... Egyedi azonosité L/1/P
B | KART Jelkulcsi azonosito Kartogrdfiai kod L/lI/N
C | TEXT Megiras Magyardzé megirds, rovidités T/*/N
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9.3 I1A_pont — Erddk és fak, vizenyés teriiletek

Feature Class: IA_pont
Geometriai tipus: PONT
Oszlop Leiras Erték Jelentés Adattipus
. |ID A tablazat sordnak azonositdja | 1,2,3,....... Autonumber
2. |F_CODE |Objektumkéd EB020 | Bokrok Text (5)
- a EB021 | Bokorcsoport
| Eco30 |Egyediilll6 fa tajékoztaté
EC031 | Nem tajékoztat6 jellegii fa
ECO015 | Erdés teriilet (ma-ban nem )
- EC035 | Facsoport
R ) ED010 | Vizenyds teriilet — fiivel
EDO015 | Vizeny6s teriilet - sésnad
3. |TRE Fatipus 1 Lombhullaté Integer
- 2 |Orokssld
. 3 Vegyes
4. INAM Név »UNK” | Ismeretlen, Text (80)
- | Szbveg |Erdéneve
A | TOPID Topogrdfiai azonosit6 | ..... Egyedi azonosito L/1/P
B | KART Jelkulcsi azonositoe ~~ |..... Kartogrdfiai kod L/I/N
C | TEXT Megiras Magyaradzo megirds, rovidités T/*/N
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9.4 IB_felulet — Mez6gazdasagi kultira
Feature Class: IB_felulet
Geometriai tipus: FELULET
Oszlop Leiras Erték Jelentés Adattipus
1. [ID A téblazat sordnak azonositéja | 1,2,3,....... Autonumber
2. |F_CODE |Objektumkadd EA010 (Szinté Text (5)
EA030 | Faiskola
- BH135 |Rizsfold
o EA035 |Kert
o _ EB010 | Fiives teriilet o
EA040 | Gyiimolcsos
EB030 |Egyéb iiltetvények
EA050 |Sz616
3. | VEG Novényzet jellege 39 Oszibarack
e 40 Alma
- 80  |Korte
B - 81 Szilva
82 [ Megy
- 83 Cseresznye
84 Kajszibarack
: o 98 Oszibarack
=T | 99 |bis
. 100 | Mandula
R - 101 Szelidgesztenye
102 Szeder
- - 85  |Ribizli
- 86 Szamoca
- 87  |Mdina
- i 88 Egres (készméte)_ o
: B 94 Koml6
"""""""""" 95 Levendula
- 96 Bodza
97 Mogyoré
. 999 |Egyéb
- 53 Fiives-bokros
_ R 80 Fives fis
81 Fiives-fas-bokros
o 998 | Nem alkalmazhat6
4. |NAM Név “UNK” | Ismeretlen, Text (80)
Szbveg | Teriilet neve
5. |FTC Miivelési kategoria 7 Kordonmiivelés Integer
) | 998 |Nem alkalmazhat6
999 Egyéb
A | TOPID Topogrdfiai azonosité | ..... Egyedi azonosito L/1/P
B | KART Jelkulcsi azonosité Kartogrdfiai kod L/I/N
C | TEXT Megiréas ... Magyardzo megirds, rovidités T/*/N
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9.5 IC_felulet — Vizi nydvényzet és mocsar
Feature Class: IC_felulet
Geometriai tipus: FELULET
Oszlop Leiras Erték Jelentés Adattipus
1. |ID A tablazat soranak azonositéja | 1,2,3,....... Autonumber
2. |F_CODE [Objektumkéd EDO030 | NAd és sds Text (5)
ED010 | Vizenyés teriilet
: _ BH095 | Mocsar
3. | PFE i‘l’é's?é‘;;elmély“g [m], 0.1 m| " 32967,0 |ismeretlen, Double
- 0,0< |Aktualis érték
4. |INAM Név »UNK” [ Ismeretlen, Text (80)
- Szbveg | Terillet neve
5. | VEG Novényzet 0 Ismeretlen Integer
R E Tézeg
' 9 Fi
. : 53 Ritka bozot
54 Siiril bozot
- 55 Fas
n 58 Néd, sés
999 Egyéb
6. | TXT Szbveg Szbveg Szdveges leirds (pl.: jarhato, jarhatatlan) Text (25)
A | TOPID Topogrdfiai azonosito Egyedi azonosito L/1/P
B | KART Jelkulcsi azonosito | ... Kartogrdfiai kod L/1/N
C |TEXT Megiras ... Magyardzo megirds, rovidités T/*/N
9.6 ID_felulet — Talajnemek
Feature Class: ID_felulet
Geometriai tipus: FELULET
Oszlop Leiras Erték Jelentés Adattipus
1. 1ID A téblazat soranak azonositdja | 1,2,3,....... Autonumber
. |F_CODE | Objektumkéd DAO10 | Talaj Text (5)
3. |MCC Talajtipus 16 Agyag
- 46 Kavies
47 K6
o - N 84 Sziklas
: - 88 Homok
123 Szikes
N 998 Tarasos S
4. | TXT Szbveg Szbveg Sz8veges leiréas (pl.: jarhatd, jarhatatlan) Text (25)
A | TOPID Topogrdfiai azonosité | ..... Egyedi azonosito L/1/P
B | KART Jelkulesi azonosite | ... Kartogrdfiai kod L/I/N
C | TEXT Megiras Magyardzo megirds, rovidités T/*N
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10 J — DOMBORZAT

10.1 JA_vonal — Szintvonal és mélységvonal

Feature Class: JA_vonal
Geometriai tipus: VONAL
Oszlop Leiras Erték Jelentés Adattipus
1. |ID A tablazat soranak azonositéja | 1,2,3,....... Autonumber
2. |F_CODE | Objektumkod CA010 |Szintvonal Text (5)
- BEOI5 | Mélységvonal
3. |crv o S[z”‘:}m“a” mélységvonal | im | Aktulis érték Double
4. |HQC Szintvonal fajtdja 1 Fészintvonal Integer
2 Szintvonal )
3 Felez6 szintvonal
o 13 Kiegészit) szintvonal
A | TOPID Topogrdfiai azonosité | ... Egyedi azonosité L/1/P
B | KART Jelkulcsi azonosité | ... Kartogrdfiai kéd L/I/N
C |TEXT Megiras ~ |... Magyardzo megirds, rovidités T/*/N
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10.2 JB_felulet — Mesterséges és természetes domborzati elemek

Feature Class: JB_felulet
Geometriai tipus: FELULET
Oszlop Leiras Erték Jelentés Adattipus
1. |ID A téblazat soranak azonositdja | 1,2,3,....... Autonumber
2. |F_CODE |Objektumkéd DB160 | Sziklafal Text (5)
o ‘DB161 |Sziklik ——
______ o DB090 | Toltés
DB091 | Arvizvédelmi tdltés
DB214 | Kéfolyé
DB081 Lyuk (tobrok) feliilete
DB200 | Vizmosasok, és horhosok
- | DB210 |Suvadss R
B DB031 |Halom, domb
: B DB080 |Godor
DB082 | Rézsii
3. |PFE :él;r:gz:el;i [ﬂz']ség (0,1 méter -32767,0 | Ismeretlen, Double
o -32765,0 | Nem jellemz6, =5
- 1,5< | Aktualis érték
Jellemz6 magassag a fold
4. |PFG felszine felett. 0,1 méter| -32767,0 |Ismeretlen, Double
élességgel [m].
""""""" -32765,0 |Nem jellemzd,
- 0,0< | Aktudlis érték
5. |WOP |G senee. gy | 327670 | tsmereten, Double
-32765,0 Nemjellemzc'i, S
- 00< |Aktualisértek
6. [NAM Név “UNK” [ Ismeretlen, Text (80)
Szoveg | Domborzati elem neve
A | TOPID Topogrdfiai azonosito Egyedi azonosito L/1/P
B | KART Jelkulcsi azonosito Kartogrdfiai kod L/I/N
C |TEXT Megiras | Magyardzo megirds, rovidités T/*/N
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10.3 JB_vonal — Mesterséges és természetes domborzati elemek

Feature Class: JB_vonal
Geometriai tipus: VONAL
Oszlop Leiras Erték Jelentés Adattipus
1. {ID A téblézat sordnak azonositéja | 1,2,3,....... Autonumber
2. |F_CODE |Objektumkod DB110 | Tereplépcsé , szakadas Text (5)
- o DB200 | Vizmosdsok, és horhosok , horpadas
"""""""""""""" DB210 |Suvadss
DB082 | Rézsii
- DB090 | Nyilgat, nyari gt
3. | PFE Jellerf'nzé mélység (0,1 méter -32767,0 | Ismeretlen, Double
élességgel) /m].
-32765,0 |Nem jellemz6,
- 1,5< | Aktualis érték
Jellemz6 magassag a fold
4. |PFG felszine felett 0,1 méter -32767,0 [Ismeretlen, Double
élességgel [m].
- -32765,0 | Nem jellemzo,
1,5< | Aktualis érték
5. |[NAM Név »UNK” [ Ismeretlen, Text (80)
o Széveg | Objektum neve
A | TOPID Topogrdfiai azonosité Egyedi azonosité L/1/P
B | KART Jelkulcsi azonosite | ... Kartogrdfiai kod L/I/N
C | TEXT Megiras  |... Magyardzo megirds, rividités T/*N
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10.4 JB_pont — Domborzati elemek

Feature Class: JB_pont
Geometriai tipus: PONT
Oszlop Leirés Erték Jelentés Adattipus
1. |ID A tablazat sordnak azonositdja | 1,2,3,....... Autonumber
2. |F_CODE Objektumkod DB160 | Egyediildll6 szikla Text (5)
) DB161 | K&tomb, k6halom
| DB030 |Barlang bejirata
| DB081 [Karsztlyukak (tobrok)
| pB080 [Gadsr
| DB031 |Halom,domb
o CA030 |Magassagi pont
Az obj. legmagasabb -32767,0 Ismeretlen,
3. |zv7 /legmélyebb pontjénak Double
tengerszint feletti magassaga
0,1 méter élességgel [m]
. ' -32765,0 | Nem jellemz,
B Aktualis érték
4. | SPE Magassagi pont kategéria 994 Uralgo Integer
- | 999 [Egyéb
5. |LEN Hosszusag [m]. (DB030) -32767 | Ismeretlen, Integer
= K R 32765 |Nem jellemz8,
R 0< |Aktualis érték
6. | WGP éséifggszfl[ ’(nlgiB%Z;O’;’ -32767,0 | Ismeretlen, Double
- | -32765,0 |Nem jellemzd,
- 0,0< |Aktudlis érték o
Jellemzd magassag/mélység a
7. | PFG fold felszine felett. 0,1 méter -32767,0 |Ismeretlen, Double
élességgel [/m].
- -32765,0 |Nem jellemzd,
0,0< Aktudlis érték
8. INAM Név “UNK” | Ismeretlen, Text (80)
Széveg | Objektum neve
A |TopPiD Topogrdfiai azonosito Egyedi azonosité L/1/P
B | KART Jelkulesi azonosité | ... Kartogrdfiai kéd L/I/N
C |1EXT Megiras |.. Magyardzo megirds, rovidités T/*/N
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11 K — SZOVEG OBJEKTUMOK

11.1 KA_pont — Teriilet, domborzat névrajz

Feature Class: KA_pont
Geometriai tipus: PONT
Oszlop Leiras Erték Jelentés Adattipus
1. |ID A tablazat sordnak azonositdja | 1,2,3,...
Autonumber
2. |F_CODE |Objektumkéd ZD041 |TEXTO1- KERET MEGIRASOK Text (5)
' ZD042 |TEXTO2 - UZEMEK,GYARAK
- E ZD043 |TEXT03 - EPULETEK,EPITMENYEK
o ZD044 |TEXTO04-VIZEK
- | zD045 | TEXTO5 - TERULETEK
ZD046 |TEXT06 - TELEPULESEK
. ZD047 |TEXT07 - MAGYARAZO TEXT
- | ZD048 |TEXTO08 - DOMBORZAT
3. |Text A szbveg megnevezése Text A szbveg tipus magyarazata Text (80)
4. |TL Réteg o 0-63 MST rétegkiosztas Long Integer
5. |Tcc Szinkéd 0-255 Szinked Long Integer
6. |TF Font tl’p:s_ _ i Text Fomi-s font tipus Long Integer
7. {TO Szé\;g_ fgaii_tés_ o Text Beszirasi poﬁt - Text (5)
8. |TMAG Szﬁuveg rEagasséga Szam Betii magaiégéga Double
9. |TSZEL Szé;/% szélesséée - Szém ﬁét"i'ims“zélessége : Double
10. [ AOO %;géfési szog - Szém Elforgatasi szbg Double
-32767,0 |Ismeretlen
A | TOPID Topogrdfiai azonosité Egyedi azonosité L/1/P
B | KART Jelkulcsi azonosité Kartogrdfiai kéd L/I/N
C | TEXT Megiras ~ |... Magyarazo megirds, rovidités T/*N
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12 L — KARTOGRAFIAI ELEMEK

12.1 LA_pont — Kartografiai cellak

Feature Class: LA_pont
Geometriai tipus: PONT
Oszlop Leiras Erték Jelentés Adattipus
. {ID A tablazat sordnak azonositéja | 1,2,3,....... Autonumber
2. |F_CODE | Objektumkdd KC001 |bokros Text (5)
KC002 | bokros gylimdlcsos
KC003 | bokros gyiimdlcsds sor
""" ) KC004 | diszkert
a KC005 |egyéb bokros ipari
KC006 |egyéb fajellegii ipari
) KC007 | eséstiiske o
KC008 | fi
KC009 |gyiimblesds
. KC010 | homokos teriilet
- KCO011 | kavicsos teriilet
KC012 | kivdgott erdd, leégett
o KC013 |koml6
KC014 | kordon jele (sz616)
KC015 | koves teriilet
KC016 |lombleveli fajelleg
KCO017 |ritka fiatal-erd6
"""""""""" KCO18 | ritka szdl-erdé
KCO019 (rizs
KC020 |sz616
KC021 |sz616 fikkal
KC022 |sds és nad
o KC023 [siird bozét lombleveli -
KC024 |sirid bozét tileveli
o KC025 |temetd jele
KC026 |tdrpe erdd
o o KC027 |tbrtvonal adatokhoz fekete
N a KC028 | tdrtvonal adatokhoz kék
KC029 | tirdsos teriilet
KC030 | tlleveli fajelleg
R KCO031 |veteményes kert
o KC032 |csonkavigdny vége
KC033 | épiileten levé tdj.torony
R ' KC034 |sird bozot tiiskés
KC035 | vill.vez. beton-,faoszlopa
KC036 |vill.vez. fém tartészerkezete
KC037 |vill.vez.nyila
3. |[AOO Elforgatasi szog Szém Elforgatasi szog Double
-32767,0 |Ismeretlen
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Oszlop Leirés Erték Jelentés Adattipus
A |TOPID Topogrdfiai azonosité | ..... Egyedi azonosité L/1/P
B | KART Jelkulesi azonosit6 | ... Kartogrdfiai kéd L/I/N
C |TEXT Megiras ~  |... Magyardzo megirds, rovidités T/*/N
12.2 LA_vonal — Kartografiai vonalas elemek
Feature Class: LA_vonal
Geometriai tipus: VONAL
Oszlop Leirés Erték Jelentés Adattipus
1. |ID A téblazat sordnak azonosit6ja | 1,2,3,....... Autonumber
2. |F_ CODE |Objektumkéd KL001 |alagut Text (5)
KL002 [alagesdvezett :
. a KLO003 | belsd keret
N KL004 | belteriileti égyéb hatar
: KL005 |csatorna szélessége : _
KL006 | duzzasztégit foldbél o ]
KL007 | duzzasztégit kébél
B ) o N KL008 €épiild csatorna -
| KrLooo |epiils at N 1
o KL010 |folyasirany B j
) - KLO11 |folyé széEst_ége -
o KL012 |gysmrajz . |
KL013 |hid_fa - o
| KLO014 |hid_fém o ] .
KLO015 |id6szakos
B - KL016 | keret o 1
KL017 |km hilézat ]
KL018 |kordon R
| KL019 | kézuti toltés_j>10m )
KL020 |Kkoziti toltés_b<=10m o ]
- - KLO021 |kozati toltés_b>10m B
- | KL022 |kozati toltés_j<=10m o
T KL023 | kiilsdkeret R ]
i KL024 lejt__szaggato-tt" N o
KL025 |lejtéalapmérték e ]
KL026 | mezei ut toltésen - N
. - KL027 |maut pontsora o B
: KL028 _nii;é_nyzethatér ______ :
o . KL029 [nyiladék o ]
T KL030 | partvonal a -
o KLO031 |rézsi_<10m i -
] KL032 |rézsii >10m -
. - KL033 |szdraz medg; ''''''
| KL034 |talajattoltésen |
] - KL035 | ut széle - -
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Oszlop Leiras Erték Jelentés Adattipus
KL036 | vasitirézsii_ j>10 m
- KL037 | vasiti rézsii_b<=10 m
- KL038 | vasiti rézsii_b>10 m
o KLO039 | vasiti rézsii_j<=10m
- KLO040 |vasiti rézsii_jobb-bal<10 o
- KLO041 |vasiti rézsii_jobb-bal>10
KL042 | vizenyds, szikes
- KL043 | vizfelilleten beliili pontsor
- KL044 | vonalas Iépték vonala
A | rorID Topogrdfiai azonosité | ..... Egyedi azonosito L/1/P
B | KART Jelkulcsi azonosit6 | ... Kartogrdfiai kéd L/I/N
C | 7EXT Megiras  |... Magyardzo megirds, rovidités /%N
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2 Adatbazis megnyitasa
2.1 Munkakoérnyezet kialakitasa

Masoljuk a sziikséges alapanyagokat a Warehouse konyvtirban az erre a célra kialakitott
alkdnyvtaraba.

= 65-213.mdb

2 65-213 t 1997 cw_tk.tif

> 65-213_t 1997 cw_tk.tfw

2.2 Inditsuk el a GeoMedia-t

- Vilasszuk ki a

- GeoWorkspace template-t
- Vaélasszuk a Normal-t - > New
- Ellendrizziik a koordinatarendszert (EOV_mm.csf)

2.3 Adatbazis megnyitasa

-> Warehouse > New Connection (Access)
-> 65-213.mdb allomanyt csatoljuk.
-> Jelenitsiik meg a csatolt adatbazisunkat:
Legend -> Add Feature Class (az 6sszes FC-t jelsljiik ki.

2.4 Munkakdrnyezet mentése

A megfeleld beéllitasokat kvetéen mentsiik el a munkakdrmyezetiinket.
File > Save GeoWorkspace As...
Hova: Sajat gépen a GeoWorkspace knyvtarba
Milyen néven: pl.: 65-222.gws



3 A GeofTiff allomanyok behivasa (amennyiben sziikséges)

Warehouse = New Warehhouse = normal
neve: 65-213 raszter.mdb
Ebbe az adattarhdzba fogjuk a sziikséges rasztereket behozni.

Ezt az adattdrhazat a raszter miatt hoztuk létre. Mivel ehhez csatoljuk hozzad a raszter fajlunkat,

elkeriiljiik azt, hogy az éles adatbadzishoz vald csatolds esetén ,rajta” hagyjuk a munka végén a
rasztert.

Insert <> Georeferenced Images
- Be kell allitani a georeferalas modjat: World file
- A helyet, ahol a raszterek vannak: warehouses\...
- Koordinatarendszer: EOV.csf
- At kell helyezni a nyil segitségével a sziikséges rasztereket balrol jobbra

- Meg kell adni, hogy mely adattarhdzba szeretnénk rakni a kivalasztott rasztereket:
65-213 raszter

- Végiil adni kell egy tetszdleges nevet (pl.: raszter)

€ tfw esetében

Insert Georeferenced Images
Georeference mode: Cootdinate system file:
]Wolld file __v_l |D'\Walehouses\VeMetek\ECIV cst Browse...
Selected mages
Foider: [D:\Warehouses\GVOP\ Biowse...
Extensions: Il"
Ayailable files: Selected files:
65213 kb 65-213_t_13897_cw_tk tf
65-213 mdb
65213 raszter idb _!’
65-213_raszter.mdb
» I
<
<« I
Insert images into
Warehouse: r
{65213 _raszter =l
Eeature classes with matching coordinate system:
Jraszter - lTl %




4 Szerkezeti atalakitas

4.1 HA_felulet — Vizhalozat és tarolok

Ennél a Feature Class-nal a kozigazgatasi hatarok szabdaljék fel a viz feliiletét. A Feature Class-ba
tartozd Osszes elem esetében sziintessik meg a daraboltsdgot a tartalmilag Osszetartozé foltok
~merge”-lésével.

=> Jelenitsiik meg a HA_felulet FC-t a térkép ablakban
-> A raszter alapjan vonjuk Ossze a tartalmilag 6sszetartozé foltokat.

- a shift billentyii segitségével jelsljiik ki azokat a foltokat, melyek tartalmilag &sszetartoznak
-> a kijelolést kévetden hasznaljuk a kévetkezd funkciot:

Edit - Feature 2 Merge

Az Osszeflizott feliiletink az elsének kijelslt folt attributum tdblazatinak a kitoltését fogja
meg0orokolni. Mivel tartalmilag azonos foltokat masolunk egybe, igy az attributum tablazatunk toltése
automatikusan megtorténik.

Itt mér 6sszefiiggd az adott feliilet



4.2 HA_vonal — Vizhal6zat

A vizrajzi elemeknél is Ossze kell kotni azokat a szakaszokat, amelyeket a hidak, atereszek és
megirasok szétszabdalnak és ez altal nem folytonosak.

Ezeket a szakadasokat kézi digitalizalassal (6sszekotéssel) lehet megsziintetni.

> A térkép ablakban meg kell jeleniteni a HA vonal FC-t és végig kell pasztazni, ahol pedig
szakadasok vannak (hidak, atereszek), 6ssze kell kotni Oket.

- Jelsljiik ki az elemet, amelyiket folytatni szeretnénk (a szakadas egyik oldala)
- Edit > Geometry - Continue

Ezzel a modszerrel elérjiik, hogy a folytatott elem Kkitoltott attribGtumai 6roklédjenek. Mivel
szakadasokat sziintetiink meg, igy biztos, hogy a p6tlasra keriil6 szakasz attributumai megegyeznek a
két oldaléval vagy legalabb is az egyikével biztos. Amelyikével megegyezik, onnan kell a digitalizalast
kezdeni.

-> El6fordulhat, hogy kiilonb6z6 elemtipust elemek talalkoznak,ezeket szintén egymashoz kell huzni.

Ilyen lehet, ha vonalas foly6 atvalt feliilet tipusuva vagy folyé (feliilet/vonalas) vizfeliiletbe kot be.
Ezekben az esetekben se maradjanak szakadasok.

- A kovetkez6 szituacioban a hid objektum alatt valt az elem tipusa.

Ilyen esetben (az el6z6 pont alapjan) is dssze kell kétni Oket. Az Gsszekdtés/elemtipus valtas térténjen
a hid kdzéppontjaban.
-> Jel6ljiik ki a feliilet tipust elemet

- Az Edit Geometry gombbal jelenitsik meg a torés pontjait, majd mozgassuk a hid
kozépvonaldval parhuzamosan, kdzépre.

-> Az Extend to Intersection gombot aktivaljuk
- Alljunk a vonalas elemiink f61¢, majd hagyjuk jova a bekotést.

g




4.3 HA_pont — Viznyerd helyek és taroldk

Ennél a Feature Class-nal nem kell szerkezeti atalakitast végezni.

4.4 HB_felulet — Mitargyak

Az eddigi feldolgozas soran nem meriilt fel olyan dolog, ami szerkezeti valtoztatast igényelne.
Altaldnossagban igaz, hogy ezeket a felilleteket se darabolja fel mas elem. Ilyen esetben meg kell
szlintetni a szakadasokat.

4.5 HB_vonal — Mitargyak

Az eddigi feldolgozas sordn nem meriilt fel olyan dolog, ami szerkezeti valtoztatast igényelne.
Altalanossagban igaz, hogy ezeket a feliileteket se darabolja fel mas elem. Ilyen esetben meg kell
sziintetni a szakadasokat.

4.6 HB_pont — Mitargyak

Ennél a Feature Class-nél nem kell szerkezeti atalakitast végezni.

7. oldal
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